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ABOUT THIS GUIDE 

InterCall, a subsidiary of West Corporation, in partnership with WebEx Communications, Inc provides TrainingCenter web 
conferencing services. Because TrainingCenter is powered by WebEx™, this guide makes several references to the company 
name, platform and features. 

HOW TO SET  UP  AND LOG INTO YOUR TRAININGCENTER  ACCOUNT 

OBTAINING A USER ACCOUNT 

Once you obtain a user account, you can use MyWebEx™ features and host training sessions on the web. 

You can obtain a user account in one of two ways: 

• The site administrator for your TrainingCenter website can create a user account for you. In this case, you need not sign up 
for an account on your site, and you can begin hosting training sessions immediately. 

• If your site administrator has made the self-registration feature available, you can sign up for an account on your 
TrainingCenter website at any time. 

LOGGING INTO AND OUT OF YOUR TRAININGCENTER SITE 

To manage your online training sessions maintain your user account, you must log in to your TrainingCenter website.  

To log in to your TrainingCenter site: 

1. Go to your TrainingCenter website. 

2. In the upper-right corner of the page, click Log In. 

3. The Log In page appears. 

4. Enter your user name and password. 

5. Passwords are case-sensitive, so you must type your password exactly as you specified it in your user profile. 

6. Click Log In. 

To log out from your TrainingCenter site  

In the upper-right corner of the page, click Log Out. 

 

SCHEDULING A TRAINING SESS ION 

ABOUT SCHEDULING A TRAINING SESSION 

When scheduling a training session you can accept the default settings that your TrainingCenter website provides, or you can 
specify several options for your training session. These options allow you to customize your training session for your specific 
needs. Once you schedule a training session, you can modify its options. You can also cancel a scheduled training session at any 
time.  

If another user has granted scheduling permission to you in his or her user profile, you can schedule a training session on behalf 
of that user.  

CHOOSING A LEVEL OF SECURITY FOR A TRAINING SESSION 

You provide security for your training session by doing any of the following: 
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• Require a password --Most TrainingCenter websites require that you specify a password for any session that you host. 
Attendees must provide this password to join the session.  

• Specify an unlisted training session --When scheduling a training session, you can specify that the session is unlisted. An 
unlisted training session does not appear on the training session calendar. To join an unlisted training session, attendees 
must provide a unique See session number.  

• Exclude the session password from email invitations --When scheduling a training session, you can prevent the password 
from appearing in the email invitations that your TrainingCenter website automatically sends to attendees.  

• Require attendees to log in --When scheduling a training session, you can require that attendees have a user account on 
your TrainingCenter website. Thus, attendees must log in to your site before they can attend the session.  

• Require attendees to register for the training session --When scheduling a training session, you can require each attendee 
to fill out a registration request that includes his or her name, email address, and other information that require, and then 
send the request to you. You can then accept or reject each registration request.  

• Restrict access to the training session --Once all attendees have joined a training session, you can prevent additional 
attendees from joining it by restricting access to the training session.  

ALLOWING ANOTHER HOST TO SCHEDULE YOUR TRAINING SESSION 

For users with an account only  

You can set up the option for other hosts in your organization to schedule a training session for you. If another host schedules a 
training session in your name, you are the only host who can start the session.  

To allow another user to schedule training sessions for you: 

1. If you have not already done so, log in to your TrainingCenter website.  

2. On the top navigation bar, click MyWebEx. 

3. Click My Profile. The My Profile page appears. 

4. Under Session Options , do either or both of the following: 

a. In the Scheduling permission box, type the email addresses of the users to whom you want to grant scheduling 
permission. Ensure that you separate multiple addresses with either a comma or semicolon. 

b. Click Select From Host List to select users from a list of all users who have accounts on your TrainingCenter website. 

5. Click Update. 

Note: A user to whom you grant permission to schedule training sessions must have an account on your TrainingCenter website. 

SETTING UP A SCHEDULED TRAINING SESSION 

When scheduling a training session, you must specify a training session topic, date and time, and password. You can also specify 
several options to provide security for and customize your training session. 

Open the Schedule Training Session page: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, expand Host a Training Session to view a list links. 

3. Click Schedule Training. The Schedule Training Session page appears. 

Set up session and access information: 

1. Specify a topic and a password for the training session.  

2. Specify whether the training session is listed or unlisted.  
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Enter your audio conference information: 

1. Under Teleconference, do the following: 

a. Select None if you do not need an audio conference. 

b. Select Reservationless-Plus from InterCall (if enabled on your website) to utilize Reservationless-Plus audio 
controls.  Please reference the InterCall Centers Audio Controls User Guide and Release Notes for more information.   

c. Select Other Teleconference to enter InterCall audio conference information to appear in the email invitation.   

Specify tracking codes: 

Required for some organizations. Specify tracking information associated with the training session.  

Schedule the date, time, and occurrence: 

1. Specify the date and time at which the training session starts, its occurrence, and its duration. 

2. Optional: Specify a recurrence pattern for the training session by selecting an option next to Occurrence.  

Set up Hands-on Lab: 

1. This option appears on the Schedule Training page only if your site administrator has set up Hands-on Lab. 

2. Reserve computers from a specific Hands-on Lab.  

3. Check availability of computers and status of your reservation. 

Specify registration options: 

1. Optional: Specify whether to require attendees to register for the training session.  

2. Optional: Customize your registration form by adding option buttons and specifying required information to register.  

Invite and specify the number of attendees: 

1. Optional: Send email invitations to attendees.  

2. Specify the estimated number of attendees for the training session.  
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Invite and specify the number of presenters: 

1. Optional: Send email invitations to presenters.  

2. Specify the estimated number of presenters for the training session.  

Specify training session options: 

1. Optional: Specify which session options you want to be available to all participants during the training session.  

2. Optional: Specify which privileges attendees have during the training session.  

3. Specify a destination web page.  

4. Optional: Choose an alert to play once a participant either joins or leaves the teleconference.  

5. Create a message or greeting that appears when attendees join the training session.  

Select email messages to be automatically sent: 

1. Select invitation email messages.  

2. Select email messages to be sent when any schedule updates occur.  

3. Send a registration notification to the host or to attendees.  

4. Send training session reminders to attendees and presenters.  

Specify session information: 

1. Specify an agenda and description for the training session, which attendees can view before the training session starts.  

2. Upload course material to the Session Information page for attendees to download before the training session.  

3. Optional: Add a picture to the Session Information page, which attendees can view before the training session starts.  

Schedule or start the training session: 

1. Do one of the following: 

a. If the training session's starting time is the current time, click Start to start the training session. 

b. If the training session's starting time is after the current time, click Schedule. 

2. The Session Scheduled page appears confirming that the session is scheduled. You also receive a confirmation email 
message that includes information about the scheduled session. 

Note: 
• Training Sessions do not start automatically at scheduled times.  
• If you invite an attendee to a training session when scheduling it, the attendee receives an invitation email message that includes 

information about the training session, including the training session password, unless you specify that passwords do not appear in email 
invitations.  

• If you invite an attendee to a training session when scheduling it, and require that attendees register to attend the session, the attendee 
receives an invitation-to-register email message. This message includes information about the training session, including a link that the 
attendee can click to register for the session. 
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USING TESTS  IN  TRAINING SESS IONS 

ADDING A TEST TO A SCHEDULED TRAINING SESSION 

To test attendees, you must add tests to the training session that they will be attending. 

Before you can add tests, do the following to turn on the Testing feature: 

1. Schedule, but do not start, a session. 

2. Require attendee registration for the session. 

3. To require attendee registration, select Attendee Registration when scheduling or updating the session. 

To add a test to a scheduled training session: 

1. Log in to your TrainingCenter website. 

2. On the navigation bar, expand Attend Session, and then click Live Sessions.  

3. Click the session topic. 

4. On the Session Information page that appears, click Add New Test. 

5. On the Add Test page that appears, select one of the following, and then click Next : 

a. Create a new test.  

b. Copy an existing test from the Test Library.  

6. Select the test you want to copy from the Test Library, and then click Next. 

7. Import test questions from saved test or poll questionnaire (*.atp file).  

8. Select the file, and then click Next. 

9. Compose or edit the test, and then click Save. 

10. Specify delivery options, such as the test date and time limit, and then click Save. The Manage Test page appears.  

11. To return to the Session Information page, click Go Back. 

12. Follow the same instructions to add multiple tests to a session. 
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UNDERSTANDING THE TEST LIBRARY 

The Test Library serves as a repository of tests on your organization's TrainingCenter website. In the Test Library, you can do the 
following: 

• Create, edit, duplicate, or delete a test 

• Import a poll or test questionnaire, with an .atp file extension, and convert it to a test 

• Copy your tests to the Shared Tests section so other training hosts can access the tests 

• Copy shared tests to the Private Tests section 

The tests you create or import appear in the Private Tests section. 

To access the Test Library: 

1. Log in to your TrainingCenter website. 

2. On the left navigation bar, expand Host a Session, and then click Test Library.  The Test Library page appears.  
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ABOUT STARTING AND MANAGING TESTS 

You can use the Manage Test page to manage every aspect of a test. 

To access the Manage Test page for a test: 

1. Select a test topic from the Test section of the Session Information page. Click the Manage button to open the Manage Test 
page. 

2. The options on the Manage Test page vary, depending on the delivery options and the status of the test. Tests can fall into 
the following categories: 

a. Pre-session tests and post-session tests -- Tests that the attendee takes before or after a training session.  

b. In-session tests -- Tests that the attendee takes during a training session.  
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MANAGING PRE-AND POST-SESSION TESTS 

Pre- and post-session tests automatically start at the time you specified on the Test Delivery Options page. 

The following table shows the management options for a pre- or post-session test. 
 

Status Management Options 

Before test starts 

Change delivery options 

Copy the test to Test Library 

Edit test questions 

Test in progress 

End test immediately 

Extend due date of the test 

View and score attendees' answers 

Copy the test to Test Library 

View test questions 

After test ends 

Re-start the test 

View and score attendees' answers 

Copy the test to Test Library 

View test questions 

MANAGING IN-SESSION TESTS 

You administer an in-session test during a training session. Attendees take the test during the session rather than before or after.  

To manage in-session tests: 

1. Specify Start this test within a live session option on the Test Delivery Options page when adding the test to the session. 

2. After the session starts, choose Testing in the drop-down list on the Participants & Communications panel. 

3. Select the title of the test, and then click Launch for All. 

4. On the page that appears, click Start Test. 
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The following table shows the management options for an in-session test. 
 

Status Management Options 

Before test starts 
Change delivery options 
Copy the test to Test Library 
Edit test questions 

After you click Launch for All  
Start the test 
Copy the test to Test Library 
Edit test questions 

Test in progress 

End the test immediately 
Increase time limit if you have specified it 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

After test ends 

Re-start the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

Test suspended in the event of a session crash 

Resume the test 
Re-start the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

CREATING A TEST 

You can create a test in the Test Library, or you create a test and then add it to a scheduled training session. 

To create a test: 

1. Do one of the following: 

a. On the Test Library page, click Create New Test. 

b. On the Session Information page, click Add New Test. Select Create a new test, and then click Next. 

The Create Test page appears. 

2. Specify the following: 

a. Test title and description  

b. Maximum score -- Select the check box and type the score in the text box to specify the maximum score an attendee 
can receive. 

c. Grade -- Select the check box to assign a grade based on the attendee's scores. Click the Specify Grades link to specify 
a grading scale. 

d. Display question -- Select one of the following: 

 All questions in one page 

 One question per page 

3. Click the Insert Question link to add a question or instructions to the test. 
The Add Question window appears. 

4. Click the Question Type drop-down list. 
The following table defines each question type. 

  

Question Type Description 
Essay  A question that requires attendees to type text answers 
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Fill in the blanks  A question that requires attendees to type text answers in the blanks 
Instructions  Instructions that you can provide attendees in the beginning of a test 
Multiple Choice  A question that requires attendees to select one correct answer 
Multiple Response  A question that requires attendees to select more than one correct answer 
True/False  A question that requires attendees to indicate whether the statement in the question is true or false 

5. In the drop-down list, do one of the following: 

a. Choose Instructions to add instructions in the beginning of the test, and then click Save. 

b. Choose one question type, compose the question, specify the correct answers, and then click Save. 

6. Follow the same instructions to add additional questions to the test. 

Note: To save you time when scoring, TrainingCenter automatically checks attendees' answers against the correct answers you specify. You must 
specify answers for all question types except Essay. Once you start a test, you cannot change the questions or answers. Ensure that the answers 
are correct before you start the test or the scoring will be incorrect.  

7. In the Scoring Panel area for each question, specify a score for the correct answer and optionally type scoring guidelines or 
comments for the person who will score the test. 

8. To rearrange questions, click the Move Up or Move Down links. To edit a question, click Edit. 

9. Click Save. 

SPECIFYING TEST DELIVERY OPTIONS 

The Test Delivery Options page appears during the process of adding a test to a scheduled training session. On this page, you 
determine when and how to deliver the test. Once you start a test, you cannot change the delivery options. 

The following figure shows an example of the Test Delivery Options page.  

Specifying a delivery method: 

Next to Delivery method, select one of the following: 

• Start this test within a live session -- You can start the test at any time during the training session. 
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• Deliver this test on the website -- Specify the starting and due dates and times for the test. Attendees can take the test 
anytime between the starting and due dates and times. 

Specifying a time limit: 

1. Next to Time limit, select one of the following: 

a. No time limit  

b. Attendees must finish the test within X minutes -- Type the length of time in the text box. 

2. If the test is set to be delivered outside the session, attendees can take the test anytime between the starting and due dates, 
but must finish the test within the specified length of time. 

Sending an email message to attendees: 

Next to Email attendees, select any of the following: 

• Invitation email to take the test -- Specifies when to send the email message before the test starts.  

• Type the number of days before the test starts to send the email in the text box. 

• Scoring and grading report -- Sends grade reports to attendees after the host finishes scoring their tests or after the host 
updates the scores or comments. 

CONVERTING TEST OR POLL QUESTIONNAIRES TO TESTS 

You can import test or poll questionnaires that were created and saved in previous versions of TrainingCenter and convert them 
to web-based tests. 

Test or poll questionnaire files have an .atp extension. 

To convert a test or poll questionnaire to a test: 

1. Do one of the following: 

a. On the Test Library page, click Import. 

b. On the Session Information page, click Add New Test , select Import test questions from saved test or poll 
questionnaire (*.atp file) , and then click Next . 

2. Select the file you want to import, and then click Next. 

3. The questionnaire is copied to the Edit Test page. 

4. Edit the questions if necessary. 

5. Click Save. 
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SCHEDULING A TRAINING SESSION FOR ANOTHER HOST 

If another host set up your name to schedule training sessions on behalf of him or her, you can schedule a training session for the 
host using the Schedule Training Session page.  

If you schedule a training session for another host, only the other host will be able to start the training session. Both you and the 
other host can modify the training session on the Edit Session page. 

To schedule a training session for another host: 

1. Log in to your TrainingCenter website. 

2. On the navigation bar, expand Host a Session to view a list links. 

3. Click Schedule Training.  The Schedule Training Session page appears. 

4. Under Session and Access Information, in the drop-down list next to Schedule for, select the host's name for whom 
you are scheduling the session.  

5. Finish completing the Schedule Training Session page.  

6. If you have completed specifying options on the Schedule Training Session page or Edit Scheduled Training Session page, 
click Schedule or Update, respectively. 

 

SETT ING UP  SESS ION AND ACCESS  INFORMATION 

SETTING UP A TOPIC NAME AND PASSWORD 

When scheduling a training session, you set up the topic name and password. You can edit the topic name and password on the 
Edit Scheduled Training Session page. 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access 
Information. 

2. Specify a topic for the training session in the Topic box. 

3. Type a password in the Set Session password box.  

4. Type the password again in the Confirm password box. 

5. If you have completed specifying options, click Schedule or Update. 

Notes: 
• A training session topic cannot contain any of the following characters: \ ` " / & < > = [ ]. 
• A training session password should contain a minimum of 6 characters, and can contain a maximum of 16 characters. A password 

cannot contain any of the following characters: \ ` " / & < > = [ ]. 
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ABOUT LISTED AND UNLISTED TRAINING SESSIONS 

When scheduling a training session or starting an instant session, you can specify whether the session is one of the following: 

• Listed for all --The training session appears on both the list of sessions and the training session calendar to anyone who 
visits your TrainingCenter website. 

• Listed for authorized users only --The training session appears on both the list of sessions and the training session 
calendar to only users who have user accounts and have logged in to your TrainingCenter website. 

• Unlisted --The training session does not appear on either the list of sessions or the training session calendar. An unlisted 
training session prevents anyone from viewing information about the session, such as its host, topic, and starting time; and 
helps to prevent unauthorized access to the session. To join an unlisted training session, an attendee must provide a unique 
session number. 

If you invite an attendee to an unlisted training session, the attendee receives an invitation email message that includes complete 
instructions for joining the training session--including the training session number--and a URL that links directly to a web page 
on which the attendee can join the training session. 

SPECIFYING WHETHER A TRAINING SESSION IS LISTED OR UNLISTED 

To specify whether a training session is listed or unlisted: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session and Access 
Information. 

2. Next to This training session is, select one of the following options: 

a. Listed for all  

b. Listed for authorized users only -- If you select this option, the training session appears on either the list of 
sessions or the training sessions page for only authorized users who have an account on your TrainingCenter website. 

c. Unlisted  

3. Click Schedule or Update. 

SPECIFYING TRACKING CODES FOR A SCHEDULED SESSION 

Your site administrator can specify that tracking code options that appear on the Schedule Training page. Tracking codes may 
identify your department, project, or other information that your organization wants to associate with your training sessions. 
Tracking codes can be optional or required, depending on how your site administrator set them up.  

To specify tracking codes for a scheduled training session:  

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Tracking Codes, and then select 
a code label in the box on the left. 

2. If your site administrator requires you to select a code from a predefined list, a list of codes appears.  

3. Do one of the following: 

a. If a list of codes appears in the box on the right, select a code from the list. 

b. Type a code in the box on the right. 

4. Repeat step 2 for each tracking code label. 

5. Click Schedule or Update. 

Note: If your site administrator has also specified that the same tracking code options appear in your user profile, you can edit your user profile 
to specify the tracking codes. The codes then appear automatically on the Schedule Training Session page. 
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SPECIFY ING DATE  AND T IME OPT IONS 

ABOUT SCHEDULING A TRAINING SESSION TIME, OCCURRENCE, AND DURATION 

You can specify the time at which a scheduled training session starts, its occurrence, and its estimated duration. The estimated 
duration provides participants with the information they need to reserve the appropriate length of time in their schedules. The 
training session does not end automatically after the duration that you specify. 

When specifying a session's occurrence, you can choose one of the following options: 

• Single-session class --A class that comprises a single training session and occurs only once--that is, it does not have a 
recurrence pattern. 

• Recurring single-session class --A class that comprises a single training session and recurs on a regular basis, such as 
daily, weekly, monthly, and so on. Attendees register for only one session. 

• Multiple session course --A course that comprises multiple training sessions--that is, a series of sessions that span over 
days, weeks, months, and so on. Attendees register once to attend all the sessions in the series. 

Notes: 
• The estimated duration is for your and attendees' planning purposes only. A training session does not end automatically after the 

estimated duration that you specify. 
• If you invite an attendee to a training session, the attendee receives an invitation email message that includes the training session's 

starting time and estimated duration.  
• If you invite attendees to a training session, their invitation email messages specify the training session's starting time in the time zone 

that you specified. However, if attendees reside in a different time zone, they can view the starting time in their time zones, in the list 
of sessions on the Live Sessions page. 

• You can specify the time at which a scheduled training session starts and the training session's estimated duration. The estimated 
duration provides participants with the information they need to reserve the appropriate length of time in their schedules. The training 
session does not end automatically after the duration that you specify. 

SCHEDULING A TRAINING SESSION TIME, OCCURRENCE, AND DURATION 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Date and Time. 

2. In the Starting time drop-down lists, select the month, day, year, hour, and minute at which you want the training session to 
start. 

3. Under Occurrence , select one of the following options: 

a. Single-session class 

b. Recurring single-session class 

c. Multiple session course 

4. Optional: In the Time zone drop-down list, select a different time zone. 

5. In the Time zone drop-down list, the time zone that you specified in your user profile is selected by default. 

6. In the Estimated duration drop down lists, select the hours and minutes for which you estimate the training session will 
continue. 

7. If you have completed specifying options on the Schedule a Training Session page or Edit a Scheduled Training Session 
page, click Schedule or Update, respectively. 

 

SETT ING UP  HANDS-ON LAB 
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ABOUT HANDS-ON LAB 

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on 
which training software is installed. Students can use these remote computers during a training session for hands-on learning and 
practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is 
effective, familiar, and consistent. 

You can schedule the following two types of Hands-on Lab sessions: 

• In-session Hands-on Lab.  

• On-Demand Hands-on Lab.  

ABOUT THE HANDS-ON LAB PAGE 

To access the Hands-on Lab page, log in to your TrainingCenter website. On the navigation bar, expand Host a Session, and 
then click Hands-on Lab. 

You can do the following from this page: 

Hands-on Labs tab 

• View a list of the Hands-on Lab computers set up by your Hands-on Lab administrator. 

• View the schedule for each of the labs. 

• Reserve computers for on-demand sessions. 

My Reservations tab 

• View the sessions you have scheduled for in-session or on-demand Hands-on Lab. 

• Change your reservations, such as inviting attendees and canceling reservations. 

RESERVING COMPUTERS FOR HANDS-ON LAB 

When scheduling a training session, you can set up a Hands-on Lab session and reserve computers for that session.  

To reserve computers for a Hands-on Lab session: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Hands-on Lab. 

2. Select Reserve computers from lab.  

3. Choose a lab from the drop-down list. Hands-on Labs are set up by your site administrator. 

4. To view the lab description or number of computers set up in a selected lab, click Lab Info. 

5. In the Number of computers box, type the number of computers that you want to reserve. 

6. To check availability of the computers and lab, click Check Availability.  The Computers Available dialog box appears 
indicating how many computers are available for the time and lab that you specified. 

7. Your reservation status appears in the Reservation status box. The reservation status refreshes each time you click Check 
Availability. 

8. To pre-assign computers to registered attendees, select require attendee registration in the Registration section of the 
Schedule Training Session page. Requiring attendee registration allows you to assign computers to attendees as they 
register.  

9. When you are finished scheduling your training session and Hands-On Lab, click Schedule at the bottom of the Schedule 
Training Session page. 
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10. If the computers are available for your scheduled Hands-on Lab, the Session Scheduled page appears with your reservation 
confirmation.  

11. If the computers are not available, the Computers Not Available page appears. Click Close, and select a new reservation 
time or number of computers on the Schedule Training Session page.  

12. Click OK. 

VIEWING THE HANDS-ON LAB SCHEDULE 

You can view the Hands-on Lab schedule from your TrainingCenter website.  

To view the Hands-on Lab schedule: 

13. Log in to your TrainingCenter website.  

14. On the navigation bar, expand Host a Session to view a list of links. 

15. Click Hands-On Lab.  The Hands-on Lab page appears. 

16. For the lab in which you are interested, under Lab Schedule, click View Schedule.  The Lab Schedule page appears.  

17. Point to a time slot to view details of the lab schedule.  

18. When finished, click Close.  

 

SPECIFY ING REGISTRAT ION OPT IONS 

ABOUT REQUIRING REGISTRATION FOR A SCHEDULED TRAINING SESSION 

You can require training session attendees to register for a training session before they can join it. Requiring registration allows 
you to view a list of attendees to determine whether they have registered for the training session, obtain attendees' names, email 
addresses, and optionally additional personal information before they can join the training session, and accept or reject individual 
registration requests. If you invite an attendee to a training session that requires registration, the attendee receives an invitation 
email message that includes information about the training session, including the registration password if you specify one, and a 
link that the attendee can click to register for the training session. 
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Notes: 
• If you accept registration requests automatically for a training session that requires a password and an attendee registers after the 

training session has already started, the attendee can join the training session immediately, without providing the password. 
Therefore, to secure a training session from unauthorized access, you must clear the Automatically accept all registration requests 
box, and manually accept or reject all registration requests.  

• If you do not accept registration requests automatically for a training session that requires a password and an attendee registers after 
the training session has already started, the attendee cannot join the training session until he or she receives a registration 
confirmation email message and can provide the training session password.  

• If you do not check for registration requests in your email program during the training session, and accept the attendee's request, the 
attendee cannot join the training session. 

REQUIRING REGISTRATION FOR A SCHEDULED TRAINING SESSION 

To require registration for a scheduled training session: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Registration. 

2. Next to Attendee Registration, select the Require attendee registration box. 

3. Optional: To customize the registration form to obtain additional information about each attendee, click Customize form. 

4. Do one of the following:  

a. To accept or reject each registration request, clear the Automatically accept all registration requests check box. 

b. To accept registration requests automatically without accepting or rejecting them individually select the 
Automatically accept all registration requests check box.  

5. Optional: Specify a password that registrants must provide to register for the session, by typing it in the Set registration 
password and Confirm registration password boxes. 

6. Specify a registration password only if you want to limit registrants to those whom you invite to register. If you invite 
attendees to register, each invitee receives an invitation email message, which contains the registration password.  
Specify a maximum number of registration requests, by typing a number in the Maximum registrations allowed box. 
Leave the box blank for unlimited registrations. 

7. Optional: Specify a date on which you will no longer accept registration requests, as follows:  

a. Select the Set registration close date check box. 

b. Select a month, date, and year from the drop-down lists. 

8. Click Schedule or Update. 

ABOUT CUSTOMIZING A REGISTRATION FORM 

If you require attendees to register for a live or recorded training session, you can customize the registration form on which 
attendees must provide information. 



G
L

O
B

A
L

 C
O

N
F

E
R

E
N

C
IN

G
 S

O
L

U
T

IO
N

S
 

 
 
 

 WWW.INTERCALL.COM   1-800-374-2441

AAP/EOE 
Last Rev.  12.18.06 

WebExTM and  MyWebExTM are either registered trademarks or 
trademarks of WebEx Communications Inc. in the United States 
and other countries. 

When customizing the form, you can choose which standard options you want to appear on the form and create any of the 
following options: 

• Text Box --Opens the Add Text Box window, on which you can specify text boxes that appear on the registration form.  

• Check Boxes --Opens the Add Check Boxes window, on which you can specify check boxes that appear on the 
registration form.  

• Radio Buttons --Opens the Add Radio Buttons window, on which you can specify radio buttons that appear on the 
registration form.  

• Drop-Down List --Opens the Add Drop-Down List window, on which you can specify a drop-down list that appears on 
the registration form. 

For each option that you add to the form, you can specify whether the information is required that is, whether attendees must 
provide the information to register for the live or recorded training session. 

About the Add Text Box window 

The Add Text Box window allows you to specify a text box that appears on the registration form. A text box allows an enrollee 
to type information on the registration form. The detailed reports that you can obtain for live or recorded training sessions 
indicate which text boxes each registrant selected when registering for a live or recorded training session. 

• Textbox name --Specifies the text that appears to the left of the text box. A text box label can contain a maximum of 256 
characters. 

• Type --Specifies whether the text box contains a single line or multiple lines on which an enrollee can type. If you select 
Multi-line, specify a number of lines in the Height box. 

• Width --Specifies the width of the text box, in characters. The number that you specify determines how the text box appears 
on the registration form, but does not affect the number of characters that an enrollee can type in the text box. Any text box 
that you add can contain a maximum of 256 characters. 

• Height --Specifies the number of lines that the text box contains. To specify a number of lines, you must first select Multi-
line under Type. If you do not specify a number of lines, TrainingCenter uses the default height, which is one line. 

About the Add Check Boxes window 

The Add Check Boxes window allows you to specify one or more check boxes that appear on the registration form. The detailed 
reports that you can obtain for live or recorded training sessions indicate which check boxes each registrant selected when 
registering for a live or recorded training session. 

• Checkbox group name --Specifies the text that appears to the left of a group of check boxes that you add to a registration 
form. To specify a group label, type it in the box. If you are adding only one check box and do not want a group label, leave 
this box blank. 

• Check box 1 to 9 --Specifies the text label that appears to the right of the check box, and whether the check box is selected 
or cleared by default on the registration form. To add a check box to the registration form, type its label in the box, then 
choose Checked or Unchecked in the drop-down list. 
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About the Add Radio Button window 

The Add Radio Button window allows you to specify radio buttons that appear on the registration form. Radio buttons allow an 
enrollee to select only one choice from a group of choices. The detailed reports that you can obtain for live or recorded training 
sessions indicate which radio buttons each registrant selected when registering for a live or recorded training session. 

• Radio button group name --Specifies the text that appears to the left of a group of radio buttons that you add to a 
registration form. To specify a group label, type it in the box. 

• Default choice --Specifies which radio button is selected by default on the registration form. To specify a default choice, 
first ensure that you have specified the labels for the radio buttons, then select the number for the button in the drop-down 
list. 

• Choice 1 to 9 --Specifies the text label that appears to the right of the radio button. To add a radio button to the registration 
form, type its label in the box. 

About the Add Drop-Down List window 

The Add Drop-Down List window allows you to specify a drop-down list box that appears on the registration form. A drop-
down list box allows a registrant to select a single option from a list. The detailed reports that you can obtain for live or recorded 
training sessions indicate which choices each registrant selected when registering for a live or recorded training session. 

• Drop-down name --Specifies the text that appears to the left of the drop-down list that you add to a registration form. To 
specify a label, type it in the box. 

• Default choice --Specifies which choice is selected by default in the drop-down list on the registration form. To specify a 
default choice, first ensure that you have specified the choices in the list, and then select the number for the choice in the 
drop-down list. If you do not want a choice to be selected by default, select None in the drop-down list. 

• Choice 1 to 9 --Specifies the text that appears for the choice in the drop-down list. To add a choice to the list, type its text 
in the box. 

CUSTOMIZING A REGISTRATION FORM 

To customize a registration form: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Registration.  

2. Select Customize form.  

3. The Customize Registration Form page appears. Under Standard Options, the following options appear: 

a. first and last name (always appears on the Registration page) 

b. email address (always appears on the Registration page) 

c. phone number 

d. fax number 

e. company 

f. title 

g. address information 
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4. Optional: Under Standard Options, do the following: 

a. For each option that you want to appear on the registration form, select the check box under  . 

b. For each option for which you want to require attendees to provide information, select the check box  

under  . 

5. Optional: Add custom options to the form by clicking one of the following: 

a. Text Box  

b. Check Boxes  

c. Radio Buttons  

d. Drop-Down List  

6. To save the customized registration form so you can use it for future scheduled sessions, click Save As. 

7. The Save Registration Form page appears. You can save up to five customized forms on this page. Type a name for your 
form in the Form Description box. Click Save.  

8. Click OK to save your changes and close the Customize Registration Form page. 

INVIT ING ATTENDEES  AND PRESENTERS   

ABOUT INVITING ATTENDEES AND PRESENTERS TO A SCHEDULED TRAINING SESSION 

To invite attendees and presenters to a scheduled training session, you can 

• specify their email addresses 

• select contacts in your personal address book 

• specify information about new contacts in your personal address book, and then select them for inclusion in your list of 
attendees 

When inviting attendees and presenters to a scheduled training session, you can select contacts in the following lists: 

• Personal contacts --Includes any individual contacts that you have added to your personal address book. If you use 
Microsoft Outlook, you can import the personal contacts that you keep in an Outlook address book or folder to this list of 
contacts.  

• My groups --Includes any contact groups that you have created for your personal address book. 

• Company address book --Your organization's address book, which includes any contacts that your site administrator 
has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its 
contacts to this address book. 

Each invitee receives an invitation email message that includes the following: 

• a link that the attendee or presenter can click to join the training session or obtain more information about it 

• the training session password, if you specified one 

• audio conference information (if audio conference information was specified) 

• the session number, which the attendee must provide if your training session is unlisted 
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INVITING ATTENDEES TO A SCHEDULED TRAINING SESSION 

To invite attendees to a scheduled training session: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Attendees, and then click List 
Attendees.  

2. The Invite Attendees page appears.  

3. Add any of the following to the list of invited attendees: 

a. Individual contacts and contact groups already in your personal address list, and individual contacts in your company 
address book.  

b. New individual attendees who are not already contacts in one of your address lists.  

4. Click Schedule or Update. 

INVITING A NEW ATTENDEE TO A SCHEDULED TRAINING SESSION 

When inviting attendees to a scheduled training session, you can add a new attendee to your list of attendees--that is, an attendee 
that is not already a contact in one of your address books. Once you specify information about a new attendee, you can add the 
attendee's information to your personal address book. 

To invite a new attendee to a scheduled training session: 

1. If you have not already done so, open the Invite Attendees page.  

2. On the Invite Attendees page, under New Attendee , provide information about the attendee, as follows: 

a. Type the attendee's full name in the Full name box.  

b. Type the attendee’s email address in the Email address box.  

3. Optional: To add the new attendee's information to your personal address book, select the Add new attendee in my 
address book check box.  

4. Click Add Attendee. 

5. The contact appears under Attendees to Invite on the Invite Attendees page. 

6. Optional: To remove the new attendee from your list of attendees, select the check box for the attendee, and then click 
Delete. 

7. To add the attendee to your list of invited attendees, click Invite.  

8. The contact appears in the Invited attendees box on the Schedule Training Session page.  

ESTIMATING THE NUMBER OF ATTENDEES FOR A SCHEDULED TRAINING SESSION 

When scheduling a training session, you must provide an estimate for the number of attendees that will attend the training 
session. Your TrainingCenter website uses this estimate to allocate the resources necessary to optimize the training session 
experience for all attendees.  
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To estimate the number of attendees: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Attendees. 

2. Type an estimated number of attendees in the Approximate number of attendees box. 

3. Click Schedule or Update. 

INVITING PRESENTERS TO A SCHEDULED TRAINING SESSION 

To invite presenters to a scheduled training session: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Presenters, and then click List 
Presenters.   

2. The Invite Presenters page appears.  

3. Add any of the following to the list of invited presenters: 

a. Individual contacts and contact groups already in your personal address list, and individual contacts in your company 
address book.  

b. New individual presenters who are not already contacts in one of your address lists.  

4. Click Schedule or Update. 

INVITING A NEW PRESENTER TO A SCHEDULED TRAINING SESSION 

When inviting presenters to a scheduled training session, you can add a new presenter to your list of presenters--that is, a 
presenter who is not already a contact in one of your address books. Once you specify information about a new presenter, you 
can add the presenter's information to your personal address book.  

To invite a new presenter to a scheduled training session: 

1. On the Invite Presenters page, under New Presenter, provide information about the presenter, as follows: 

a. Type the presenter's full name in the Full name box.  

b. Type the presenter's email address in the Email address box.  

c. Optional: Type the presenter's phone number in the Phone Number boxes: Country/Region, Area or city code, 
Number, and Extension. 

d. Optional: To add the new presenter's information to your personal address book, select the Add presenter as 
attendee in my address book check box.  

2. Click Add Presenter. 

3. The contact appears under Presenters to Invite. 

4. Optional: To remove the new presenter from your list of presenters, select the check box for the presenter, and then click 
Delete. 

5. To add the presenter to your list of invited presenters, click Invite. 
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ESTIMATING THE NUMBER OF PRESENTERS FOR A SCHEDULED TRAINING SESSION 

When scheduling a training session, you must provide an estimate for the number of presenters that will attend the training 
session. Your TrainingCenter website uses this estimate to allocate the resources necessary to optimize the training session 
experience for all participants.  

To estimate the number of presenters: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Presenters. 

2. Type an estimated number of presenters in the Approximate number of presenters box. 

3. Click Schedule or Update. 

INVITING CONTACTS IN YOUR ADDRESS BOOK TO A SCHEDULED TRAINING SESSION 

To invite a contact in your address book to a scheduled training session:  

1. If you have not already done so, open the Invite Attendees page.  

2. On the Invite Attendees page, click Select Contacts.  The Select Contacts page appears. 

3. Next to View, in the drop-down list, select one of the following contact lists: 

a. Personal Contacts  

b. Company Address Book  

c. My Groups  

A list of all contacts in the list that you selected appears.  

4. Select the check box for each individual contact or contact group that you want to add to your list of attendees.  

5. When selecting contacts, you can do the following: 

a. In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, 
the name Susan Jones appears under S.  

b. To search for a contact in the list that you are currently viewing, type text that appears in either the contact's name or 
email address in the Search for box, then click Search. 
If the entire list of contacts does not fit on a single page, view another page by clicking the Next Page button or the 
Previous Page button. 

c. To select all contacts that currently appear in the list, click Select All.  

d. To clear all selections in the current list, click Clear All.  

e. To add all selections to your list of attendees, click Add Attendees.  

6. The Select Contacts page closes and the Invite Attendees page reappears. The contacts that you selected appear under 
Attendees to Invite. 

7. Optional: To remove the contact from your list of attendees, select the check box for the contact, and then click Delete. 

8. To add the contacts to your list of invited attendees, click Invite. 

Note: If you later modify the training session to remove an attendee from your participant list, you can optionally send the attendee an automatic 
email message that informs the attendee that the training session was canceled. 

 

SPECIFY ING TRAINING SESS ION OPTIONS 
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SPECIFYING OPTIONS AVAILABLE TO PARTICIPANTS DURING A TRAINING SESSION 

When scheduling a training session, you can specify options or privileges available to participants during a session. The 
privileges that you select determine the default privileges that attendees have once you start the training session. 

To specify attendee privileges when scheduling a training session: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options. 

2. Click Edit Options.  The Session Options page appears. 

3. Under Attendee Privileges, specify attendee privileges as follows: 

a. To grant a privilege to all attendees, select its check box. 

b. To remove a privilege from all attendees, clear its check box. 

4. Click Save to close the Session Options page. 

5. Click Schedule or Update. 

Note:  A presenter can grant the following privileges to or remove them from attendees during a training session, whether or not you select them 
on the Session Options page: 

• Save  
• Print  
• Annotate  
• Attendee list  
• Thumbnails  
• Next or previous pages  
• Chat  
• Recording  

If you do not select the following privileges, their associated features are not available during a training session: Video, Chat, File transfer, and 
Recording. 

SPECIFYING SECURITY OPTIONS FOR A TRAINING SESSION 

When scheduling a training session, you can specify security options to prevent unauthorized attendees from joining. 

EXCLUDING THE SESSION PASSWORD FROM EMAIL INVITATIONS 

If you invite attendees to a training session, you can prevent the password from appearing in the email invitations that your 
TrainingCenter website automatically sends to attendees.  

To exclude the session password from email invitations: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options. 

2. Click Edit Options. The Session Options page appears. 
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3. Under Security, select the Exclude password from emails sent to attendees check box. 

4. Click Save. 

REQUIRING ATTENDEES TO LOG IN TO YOUR TRAININGCENTER WEBSITE 

You can require attendees to have a user account on your TrainingCenter website to join the training session. Thus, attendees 
must log in to your site before they can attend the training session 

Note: This is an optional feature. Please contact your sales representative to have this feature enabled on your TrainingCenter website.. 

To require attendees to log in to your TrainingCenter website: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options. 

2. Click Edit Options.  The Session Options page appears. 

3. Under Security, select the Attendees must have an account on this service to attend session check box. 

4. Click Save. 

ALLOWING ATTENDEES TO SHARE UCF MEDIA FILES 

When scheduling a training session, you can allow attendees to share Universal Communications Format (UCF) media files 
during the session, either in a UCF multimedia presentation or as standalone UCF media files. You can also prevent attendees 
from sharing UCF media files during a session. If you do so, only you, the session host, can share UCF media files when also 
acting as the presenter. 

You may want to prevent attendees from sharing UCF media files, for example, if you intend to allow attendees to share 
presentations or documents but want to prevent an attendee from inadvertently sharing a very large media file. 

To allow attendees to or prevent them from sharing UCF media files: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to Session Options, and then click 
Edit Options. 

2. Under Universal Communications Format (UCF), do one of the following: 

a. To allow attendees to share UCF media files, select the Allow attendees to share UCF objects check box. 

b. To prevent attendees from sharing UCF media files, clear the Allow attendees to share UCF objects check box. 

3. Click Save to close the Session Options page. 

4. Click Schedule or Update. 

Note: If you allow attendees to share UCF media files, the presenter must also grant them the Share documents privilege during the session.  

SPECIFYING A DESTINATION WEB PAGE AFTER THE SESSION ENDS 

While scheduling a training session, you can specify a destination web page or website that attendees view automatically after the 
training session ends.  
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To specify a destination URL: 

1. On the Schedule Training page or Edit Scheduled Training Session page, scroll to Session Options. 

2. Type a destination website address (URL) in the Destination address (URL) after session box. 

3. Click Schedule or Update. 

CREATING A MESSAGE OR GREETING FOR A SCHEDULED TRAINING SESSION 

You can create a message or greeting that optionally appears in an attendee's session window when the attendee joins a scheduled 
training session. For example, you can welcome the attendee to the training session, provide important information about the 
training session, or provide special instructions. Attendees can view the greeting or message at any time during the training 
session. 

To create a message or greeting for a scheduled training session: 

1. On the Schedule Training page or Edit Scheduled Training Session page, scroll to Session Options.  

2. Next to Greeting message, click Customize greeting message when attendee joins.  The Create an Attendee 
Greeting page appears. 

3. Optional: Select the Display this message when attendees join the session check box. 

4. Type a message or greeting in the Message box. 

5. A message or greeting can contain a maximum of 255 characters. 

6. Click OK. 

7. Click Schedule or Update. 

Notes: Attendees can view the message or greeting at any time during a training session, by choosing Welcome Message on the Session menu. 

ABOUT THE SESSION OPTIONS PAGE 

To access this page: On the navigation bar, expand Host a Session , click Schedule Training, and then scroll to Session 
Options. Then click Edit Options.  

Use the Session Options page to do the following: 

• Specify which options are available during the training session. 

• Specify security options. 

• Specify whether attendees can share UCF rich media files. 

Attendee Privileges  

Specifies which options are available to attendees during the session. If an option is not selected, it is unavailable during the 
session. 

Note: A presenter can turn any option on or off during the training session. 
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Documents:  

Save: If selected, specifies that all attendees can save any shared documents, presentations, or whiteboards that appear in their 
content viewers. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you 
select it here. 

Print: If selected, specifies that all attendees can print any shared documents, presentations, or whiteboards that appear in their 
content viewers. A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you 
select it here. 

Annotate: If selected, specifies that all attendees can annotate any shared documents or presentations, or write and draw on 
shared whiteboards, that appear in their content viewers, using the toolbar that appears below the viewer. A presenter can grant 
this privilege to or remove it from attendees during a training session, whether or not you select it here. 

View:  

Attendee list: If selected, specifies that all attendees can view the participant list on the Participants & Communications panel. 
A presenter can grant this privilege to or remove it from attendees during a training session, whether or not you select it here.  

Video: If selected, specifies that video is available during a training session--that is, the Video tab appears in the session 
window. If you clear this option, the Video tab does not appear in the Session window. 

Thumbnails: If selected, specifies that all attendees can display miniatures of any pages, slides, or whiteboards that appear in 
their content viewers. This privilege allows attendees to view miniatures at any time, regardless of the content that appears in the 
presenter's content viewer. However, attendees with this privilege cannot display a miniature at full size unless they also have the 
View any page privilege. A presenter can grant this privilege to or remove it from attendees during a training session, whether or 
not you select it here. 

Next or previous page: If selected, specifies that all attendees can view any pages, slides, or whiteboards that appear in their 
content viewers. This privilege allows attendees to navigate independently through pages, slides, or whiteboards. A presenter can 
grant this privilege to or remove it from attendees during a training session, whether or not you select it here. 

Other:  

Chat: If selected, specifies that chat is available during a training session--that is, chat options appear on the Participants & 
Communications panel in the Session window. If you clear this option, chat options do not appear on the Participants & 
Communications panel.  

File transfer: If selected, specifies that the presenter can transfer files to attendees during a training session. If you clear this 
option, the Transfer option does not appear on the File menu in the Session window, and the presenter cannot transfer files to 
attendees during a training session.  

Recording: If selected, specifies that recording options are available during a training session--that is, the training session host 
and the presenter can record a training session, and the presenter can grant recording privileges to attendees. If you clear this 
option, recording options are not available during a training session.  
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Security:  

Exclude password from emails sent to attendees: If selected, prevents the training session password from appearing in the 
email invitations, to help increase the security for your training session. If you exclude the password in email invitations, 
however, you must provide the password to attendees using another method for example, by phone. 

Attendees must have an account on this service to attend session: Specifies that all attendees must have an account and 
log in to your TrainingCenter website to attend the training session.  

Universal Communications Format (UCF):  

Allow attendees to share UCF objects: Allows attendees to share Universal Communications Format (UCF) media files 
during the training session, either in a UCF multimedia presentation or as standalone UCF media files. A host who is also the 
presenter can always share UCF media files, whether or not you select this check box. 

 

SELECT ING EMAIL  MESSAGES TO BE  SENT 

ABOUT SENDING DEFAULT EMAIL MESSAGES 

While you are scheduling your training session, you can select the default email messages that you send to attendees. You can 
also customize the TrainingCenter email message templates by editing, rearranging, or deleting the text and variables--code text 
that TrainingCenter recognizes and substitutes with your specific training session information.  

On the Schedule Training Session page or Edit Training Session page, under Email options, select the checkbox next to each 
email message that you want TrainingCenter to send automatically to attendees.  You can also click the title of the email to 
modify the content.  

You can select any or all of the following options: 

• Under Invitations, you can select any or all of the following invitation email messages: 

o Invitation to Join a Training Session 

o Invitation to a Training Session in Progress 

o Invitation to Register for a Training Session 

• Under Updates , you can select any or all of the following email messages informing attendees of updates to your training 
session: 

o Training Session Rescheduled 

o Updated Information to Join a Training Session 

o Updated Information to Register for a Training Session 

o Training Session Cancelled 

• Under Registrations, you can select any or all of the following email messages sent to you regarding registration to your 
training session: 

o Registration Notification to Host (You cannot change this default email message.) 

o Attendee Registration Pending 

o Attendee Registration Confirmed 

o Attendee Registration Rejected 

• Under Reminder, you can send the following email message to remind attendees, presenters, and yourself of your training 
session before it starts. You can choose to send this message from 15 minutes to 48 hours before the session starts.  
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o Training Session Reminder to Attendees  

SENDING AN INVITATION TO A TRAINING SESSION 

When you are scheduling a training session, you can choose to have your TrainingCenter automatically send invitation email 
messages to attendees. When you select an email message to send, you can send the default email message or choose to 
customize the message.  

To send an automatic invitation to a training session: 

1. On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.  

2. Under Invitations, select the checkbox next to any of the following: 

a. Invitation to Join a Training Session  

b. Invitation to a Training Session in Progress  

c. Invitation to Register for a Training Session  

3. Click Schedule or Update. 

SENDING AN UPDATE TO A SCHEDULED TRAINING SESSION 

When you are scheduling a training session, you can choose to have your TrainingCenter automatically send email messages to 
attendees whenever you update your scheduled training session. When you select an email message to send, you can send the 
default email message or choose to customize the message.  

To send automatic updates to attendees: 

1. On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.  

2. Under Updates , select the checkbox next to any of the following: 

a. Training Session Rescheduled  

b. Updated Information to Join a Training Session  

c. Updated Information to Register for a Training Session  

d. Training Session Cancelled  

3. Click Schedule or Update. 

SENDING A REGISTRATION NOTIFICATION TO A SCHEDULED TRAINING SESSION 

When you are scheduling a training session, you can choose to have your TrainingCenter automatically send email messages to 
you whenever an attendee registers and automatically send email messages to attendees when their registration status changes. 
When you select an email message to send, you can send the default email message or choose to customize the message.  
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To send automatic updates to attendees: 

1. On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.  

2. Under Registrations, select the checkbox next to any of the following: 

a. Registration Notification to Host (You cannot change this default email message.) 

b. Attendee Registration Pending  

c. Attendee Registration Confirmed  

d. Attendee Registration Rejected  

3. Click Schedule or Update. 

SENDING A REMINDER FOR A SCHEDULED TRAINING SESSION 

You can send training session reminders to attendees and presenters and to yourself from 15 minutes to 48 hours before a 
scheduled training session. When you select an email message to send, you can send the default email message or choose to 
customize the message.  

To send reminders for a scheduled training session: 

1. On the Schedule Training Session page or the Edit Scheduled Training Session page, scroll to Email options.  

2. Under Reminder, select the checkbox next to Training Session Reminder to Attendees. 

3. Under Send reminder emails to, you can select the time before a training session that you want reminders to be sent. You 
can select from 15 minutes to 48 hours.  

4. Next to attendees and presenters, in the drop-down list, select the time before a training session that you want reminders 
sent to attendees and presenters. 

5. Next to host, in the drop-down list, select the time before a training session that you want a reminder sent to you. 

6. Next to via email address, type the email address to which you want your TrainingCenter to send you a reminder, in the 
following format: name@domain.com  

Note: Do not type multiple email addresses in the box. If you do, your TrainingCenter will not send the reminder. 

7. Click Schedule or Update. 

ABOUT CUSTOMIZING EMAIL MESSAGES 

You can customize the default email messages for your preferences. You can delete variables, but do not change the text within 
the percentage signs (example, %ParticipantName%). 

If you change these, Training Manager will not substitute the correct text from your profile or registration information. 

You can edit the following options in the Edit Email Message window. 

• Email Subject – Specifies the text that appears in the subject line of the email message. 
To specify a new subject, type it into the box. 

• From -- Specifies the email address of the sender of the email message. This address appears in the email message that 
enrollees or attendees receive. By default, TrainingCenter specifies the email address that you specified in your user profile. 
To specify a different email address, type it in the box. An email address must have the following format: 
someone@your_company --for example, msmith@mycompany.com  

InterCall recommends that you set up an email account that you use exclusively for producing events. Then specify that address 
for the account in the From box. For example, you can set up an account with the address events@your_company.com.  
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• Reply To -- Specifies the email address to which you want all replies to this message to be sent. You can use the same 
address that you specified in the From box, or a different address. By default, TrainingCenter specifies the email address 
that you specified in your user profile. To specify a different address, type it in the box. An email address must have the 
following format. someone@your_company --for example, msmith@mycompany.com  

• Content -- Specifies the content of the email message. The default content contains variables, which TrainingCenter 
replaces with your training session information. You can rearrange, delete, or replace variables and text with specific 
information. Do not change the text within a variable.  

CUSTOMIZING AN EMAIL MESSAGE 

To customize an email message: 

1. On the Schedule Training Session page or Edit Scheduled Training Session page, under Email options, click the email 
message that you want to customize.  The Edit Email window appears. 

2. Edit the email message. Be sure not to change the text within a variable.  

3. To save your edited email message, click Update.  

4. Optional: To return the email message to the default message, click Reset to Default. If you click OK, the default email 
message replaces any edits that you have made.  

EMAIL MESSAGE VARIABLES 

Each variable used in TrainingCenter Email Messages is replaced by corresponding information you provide when scheduling a 
training session. In the following table, you can find not only the meaning of each variable but also the Email Messages to which 
it applies. 

 

This variable... is replaced by... for use in these  
email messages. 

%EmailFooter%  A website's email signature. All 
%HostEmail%  The email address that you specified your user profile. All 
%HostName%  The first and last name that you specified in your user profile. All 

%ParticipantName%  First and last names that the participants specified when either 
enrolling for or joining a training session. All 

%PhoneContactInfo%  

If you specified a phone number in your user profile, the following 
text:  
call %HostPhone% , where %HostPhone% is replaced by the phone 
number that you specified in your user profile. 

Attendee Registration 
Confirmed 
Training Session 
Reminder to Attendees 

%RegistrationID%  
  

The enrollment ID for the attendee. TrainingCenter automatically 
creates this ID for an attendee after you approve his or her enrollment 
request. If you do not require enrollment for the training session, this 
variable is replaced by following text: 
(This training session does not require an enrollment ID.)  

Attendee Registration 
Confirmed 
Training Session 
Reminder to Attendees 
  

%SessionDateOrRecurrence%  

If the session is a single session, then display:  
[SessionDate]  
If the session is a recurring session or multiple-session course, display: 
[SessionRecurrence]  

Attendee Registration 
Confirmed 
Training Session 
Reminder to Attendees 
  

%SessionInfoURL%  
The web address, or URL, for the Training Information page for the 
training session. Training Manager automatically creates the URL 
once you schedule a training session. 

All 

%SessionNumber%  The number of your session specified by Training Manager. All 

%SessionPassword%  

The password for the training session that you specified when 
scheduling the training. 
If you do not require a password, this variable is replaced by the 
following text: 
(This training session does not require a password.) 

Attendee Registration 
Confirmed 
Training Session 
Reminder to Attendees 
  

%SessionTime%  The time that you specified when scheduling the training session in the All 
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  following format: 
HH:MM [am/pm]. For example: 12:30 pm  

%TeleconferenceInfo%  

The following text: 
To join the teleconference, call %CallInNumber% and enter the 
training session number.  
Where %CallInNumber% is replaced by the number(s) that you 
specified in the Phone numbers box when scheduling the training. 

All 

%TimeZone%  
  The time zone that you specified when scheduling the training. All 

%Topic%  The training session topic that you specified when scheduling the 
training. All 

 

SPECIFY ING SESS ION INFORMATION 

SETTING YOUR AGENDA 

You can specify an agenda for a scheduled training session. The agenda appears on the Agenda page on your TrainingCenter 
website, which attendees can view before the training session starts. 

If you invite an attendee to the training session, the attendee receives an invitation email message that includes a link that the user 
can click to view the training session's agenda. 

To set your training session agenda: 

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to Session Information. 

2. Next to Agenda, select Plain text or HTML (formatted). 

3. Type the training session's agenda in the Agenda box. 

4. Next to Description, select Plain text or HTML (formatted). 

5. Type a description of the training session in the Description box.  
The agenda and description appear on the Session Information page available for training session participants to view.  

6. Click Schedule or Update. 
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ADDING A PICTURE TO THE SESSION INFORMATION PAGE 

You can add a picture to a training session description. The picture appears on the Session Information page, which attendees can 
view before the training session starts.  

The picture that you add must be: 

• a graphics file that is in the GIF or JPEG format 

• approximately 38 x 75 pixels  

• less than 100K in size 

To add a picture to a training session description: 

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to Session Information. 

2. Click Import Picture. The Upload Your Picture page appears. 

3. Click Browse. 

4. Select the file that you want to add to your training session description. 

5. Click Import. 

6. Training Manager imports your picture and adds it to the Session Information page for the training session. 

7. Optional: To remove your picture from the Session Information page, click Remove Picture. 

8. Click Schedule or Update. 

 

D ISPLAY ING QUICKSTART  

ABOUT QUICKSTART 

The QuickStart page allows the host, presenters and panelists to quickly display a document, application or other item they want 
to share during a training session. If the Display QuickStart option is selected by the host in the Session Information section of 
the Schedule Training Session page, the QuickStart will appear for the host, presenters, and panelists when a training session 
or breakout session begins.  

To display QuickStart for a training session or breakout session: 

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to Session Information. 

2. Next to Display QuickStart, select the check box for Main training sessions or Breakout sessions. 

3. Click Schedule or Update. 
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PUBL ISHING COURSE  MATERIAL  FOR A  SCHEDULED TRAINING 
SESS ION 

You can publish course material for participants to download before you start a session.  

ABOUT PUBLISHING COURSE MATERIAL FOR A SCHEDULED TRAINING SESSION 

When scheduling a training session, you can publish files and course material on your TrainingCenter website. This option lets 
participants download course material for review, preparation, testing, and so on before the session starts. To publish course 
material, you can either select files already in your personal folders in My Files, or upload new files to My Files first and then 
select them for publication on your site. 

Once you publish course material, participants can download it from the Session Information page on your TrainingCenter 
website. Once you approve participants' registrations, they receive a confirmation email message that contains a link to the 
Session Information page.  

Any file that you publish that is in the Universal Communications Format (UCF), which has a .ucf extension, automatically 
opens in your content viewer once you start the session. If participants have downloaded a published UCF file before the session 
starts, it automatically opens in their content viewers as well once you start the session. Up to 10 published UCF files will 
automatically open in the content viewer. 

To download UCF files that you publish, participants must install software that automatically caches, or stores, the file on their 
computers. Once a participant accesses the Session Information page on which you have published a UCF file, a security 
warning message box appears, in which the participant must click Yes to install the caching software. 

If a participant does not install the software, he or she cannot download the UCF file, and it will not open automatically in his or 
her content viewer once you start the session. 

To publish course material on your TrainingCenter site: 

1. On the Schedule Training Session page or Edit Scheduled Training Session page, scroll to Course Material. 

2. Click Add Course Material.  The Add Course Material page appears. 

3. Do the following: 

a. To upload the course material files to My Files, click the My Files link.  

b. To publish files already in My Files, select the check box next to the name of the file or files that you want to publish, 
then click Select.  

4. The file or files appear on the Schedule Training Session page, under Session Information. 

5. Optional: To remove a file, click Remove next to the file name. 

6. Click Schedule or Update. 

Notes: 

• You can customize the registration confirmation email message to instruct participants to download course material before the 
session starts. If you publish a UCF file, you can also instruct participants to click Yes when the Java security message appears on the 
Session Information page, which allows them to download the UCF file.  

• If you provide a description of a file in your personal folders, the description appears under the file name on the Session Information 
page. This description can help participants to identify the course material. You can provide a description when either initially storing 
the file in your personal folders, or at any time by editing the file's description.  

• If you specify a password for your training session, participants must provide the password on the Session Information page to 
download the course material. 

• You can update or remove course material that you published at any time, by editing the scheduled training session. To remove a file, 
click Remove next to the file name. To update a file, remove it first, and then publish the updated file. 
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US ING MYWEBEX  

ABOUT MYWEBEX 

MyWebEx is an area on your TrainingCenter website in which you can access your user account and personal productivity 
features. The following features are available, depending on the configuration of your site and user account: 

• Personal list of meetings: Provides a list of all the online sessions that you are hosting and attending. 

• One-Click Meetings: Optional feature. Lets you set up a training session that you can quickly start at any time, as often 
as you want, by clicking a One-Click Meeting shortcut on your computer. 

• Personal Meeting Room: Optional feature. A page on your TrainingCenter website on which visitors can view a list of 
sessions that you are hosting and join session in progress. Also lets visitors access and download files that you share.  

• Access Anywhere: Optional feature . Lets you access and control a remote computer from anywhere in the world.  

• File storage: Lets you store files in personal folders on your TrainingCenter website, where you can access them on any 
computer that has access to the Internet. Also lets you make specific files available on your Personal Meeting page, so 
visitors to your page can access them. 

• Recorded training session management: Lets you maintain recorded training sessions and publish them on your 
TrainingCenter website.  

• Address book: Lets you keep information about your personal contacts on your TrainingCenter website. Using your 
address book, you can quickly access contacts when inviting them to a training session. 

• User profile: Lets you maintain your account information, such as your user name, password, and contact information. 
Also lets you specify another user who can schedule meetings on your behalf and specify options for your Personal Meeting 
Room page. 

• Website preferences: Lets you specify the home page for your TrainingCenter website--that is, the page that appears 
first whenever you access your site. If your site provides multiple languages, you can also choose a language and locale in 
which to display text on your site. 

• Usage reports: Optional feature. Lets you obtain information about training sessions that you hosted. If you use the 
Access Anywhere option, you can also obtain information about computers that you access remotely. 

USING YOUR L IST  OF  MEET INGS 

ABOUT YOUR LIST OF MEETINGS 

On your TrainingCenter website, your My Meetings page in MyWebEx includes: 

• A list of all the training sessions that you have scheduled, including both listed and unlisted training sessions 

• A list of all training sessions on your site to which you are invited 

• The One-Click Meeting Wizard, which lets you set up a One-Click Meeting.  

OPENING YOUR LIST OF MEETINGS 

You can open your personal list of scheduled meetings on your TrainingCenter website to: 

• Start a training session 

• Modify a training session 

• Cancel a training session 

You can open your personal list of meetings to which you are invited to: 
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1. Obtain information about a training session 

2. Join a training session in progress 

To open your list of meetings: 

1. Log in to your TrainingCenter website, and then click MyWebEx. 

• The My Meetings page appears, showing your list of scheduled training sessions. 

2. Optional: To view the list of training sessions to which you are invited, click the Invited tab. 

MAINTAINING YOUR LIST OF SCHEDULED MEETINGS 

Once you schedule a training session, it appears in your list of meetings on your My Meetings page.  

An online training session remains on your My Meetings page until you delete it. When scheduling a training session, you can 
choose to automatically delete the training session from your list of meetings once both of the following occur: 

• You start and end the training session. 

• The scheduled time for the training session has passed. 

However, if you required registration for a scheduled training session, the training session remains in your list until you remove 
it. That way, you can still view information about attendees who registered for the training session at any time after you host the 
training session. 

To remove a training session from your list of meetings on your My Meetings page, you must cancel the training session, by 
deleting it on this page. 
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ABOUT THE MYWEBEX MEETINGS PAGE 

How to access this page 

On your TrainingCenter website, click MyWebEx. 

What you can do here 

Access the following: 

• A list of training sessions you are hosting 

• A list of any a training sessions to which you are invited 

• The One-Click Meeting Wizard 

Options on this page 

Use this option... to... 
Scheduled  View a lists all of the online training sessions that you are hosting.  
Invited  View a list all of the training sessions to which you have been invited.  

Set Up One-Click  Start the Set Up One-Click Meeting Wizard, to specify options for a training session and shortcuts on your 
computer. You can click a shortcut to start the training session at any time.  

One-Click Meeting  Start the Set Up One-Click Meeting Wizard, to modify the options a One-Click Meeting that you have 
already set up. 

Personal Meeting 
Room URL  

Go to your Personal Meeting Room page. 
Your Personal Meeting Room page lists any training sessions that you scheduled and any in-progress 
meetings that you are currently hosting. 
Users to whom you provide your personal URL can use this page to join any training session that you are 
hosting. They can also download files in any folders that you share. 

  
Refresh  

Refresh the information in the meeting list. 

 



G
L

O
B

A
L

 C
O

N
F

E
R

E
N

C
IN

G
 S

O
L

U
T

IO
N

S
 

 
 
 

 WWW.INTERCALL.COM   1-800-374-2441

AAP/EOE 
Last Rev.  12.18.06 

WebExTM and  MyWebExTM are either registered trademarks or 
trademarks of WebEx Communications Inc. in the United States 
and other countries. 

ABOUT THE MYWEBEX MEETINGS - SCHEDULED TAB 

How to access this tab 

On your TrainingCenter website, click MyWebEx > My Meetings. 

Links on this tab 

Link on the 
Schedule tab Description 

Topic  The topic for a training session that you are hosting. If you are the alternate host for a training session, the 
topic appears in italics. 

Type  Indicates the type of online session that you are hosting. Available session types depend on the configuration 
of your TrainingCenter website. 

 
Requests Pending  

Applies only to sessions that require registration. The number of registration requests that are pending--that 
is, requests that you have neither accepted nor rejected.  
Click the link for the number to open a page on which you can view details about and accept or reject each 
registration request. 

 
Requests Accepted  

Applies only to sessions that require registration. The number of registration requests that you have accepted.  
Click the link for the number to open a page on which you can view details about each accepted registration 
request. 

 
Requests Rejected  

Applies only to sessions that require registration. The number of registration requests that you have rejected. 
Click the link for the number to open a page on which you can view details about each rejected registration 
request. 

Starting Time  The date and time at which you scheduled the training session to begin. 

Status  

The status of the training session. 
Start: You can start this training session at any time by clicking the this link.  
Join | End: This training session is in progress. Appears if you left a training session, or you allowed 
participants to join the training session before its starting time and participants have already joined the 
training session. 
Join: Lets you join the training session in progress. 
End: Ends the training session. 
  

Select All  
Selects the check boxes for all the training sessions in the list. 
You cannot select a training session that is currently in progress. 
  

Clear All  Clears the check boxes for all the training sessions that are selected in the list. 
  

Delete  

Cancels any training sessions that are currently selected in the list. If you click this link, a message appears, 
allowing you to confirm that you want to cancel the training session. Another message appears, allowing you 
to inform any invited attendees that you canceled the training session. 
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ABOUT THE MYWEBEX MEETINGS - INVITED TAB 

How to access this tab 

On your TrainingCenter website, click MyWebEx > Invited. 

Links on this tab 

Link on the 
Invited tab Description 

Topic  The topic for the training session. Click the link to display a page on which you can view detailed 
information about the training session. 

Type  The type of session to which you are invited. Available session types depend on the configuration of your 
TrainingCenter website. 

Starting Time  The date and time at which the training session will start. 

Status  

The status of the training session. 
Join Now: Indicates that you can join the meeting. 
Not Started: Indicates that the meeting has not yet started. You cannot join the meeting. 
Registration: Indicates that the meeting requires registration. To display a page on which you can register to 
attend the meeting, click the link. 
  

 

MAINTAINING YOUR PERSONAL MEET ING ROOM PAGE 

ABOUT YOUR PERSONAL MEETING ROOM PAGE 

Your user account includes a Personal Meeting Room page on your TrainingCenter website. Users who visit your page can: 

• View a list of any online sessions that you are hosting, either scheduled or in currently progress.  

• Join a session in progress 

• View your personal folders and upload or download files to or from your folders, depending on the settings you specify for 
your folders 

You can customize your Personal Meeting Room page by adding images and text to it.   

To provide users with access to your Personal Meeting Room page, you must provide them with your Personal Meeting Room 
URL. 

Note: Add your Personal Meeting Room URL to your business cards, your email signature, and so on. 

VIEWING YOUR PERSONAL MEETING ROOM PAGE 

You can view your Personal Meeting Room page at any time, by going to the URL for the page. The URL for your Personal 
Meeting Room page is available on your: 

• My WebEx Meetings page 

• My WebEx Profile page 
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To view your Personal Meeting Room page: 

1. Log in to your TrainingCenter website, and then click MyWebEx. The My WebEx Meetings page appears. 

2. Click the link for Personal Meeting Room URL. 

3. Alternatively, in MyWebEx, click My Profile, and then click the Personal Meeting Room URL link, which is under the 
Personal Meeting Room section. 
Your Personal Meeting Room page appears. The following is an example of a Personal Meeting Room page. 

Note: Add your Personal Meeting Room URL to your business cards, your email signature, and so on. 

SETTING OPTIONS FOR YOUR PERSONAL MEETING ROOM PAGE 

You can add the following to your Personal Meeting Room page: 

• An image to your page. For example, you can add a picture of yourself or your company's product. 

• A custom "banner" image to the header area of your Personal Meeting Room page, if your user account has the "branding" 
option. For example, you can add your company's logo. 

• A welcome message. For example, you can provide a greeting; instructions on joining an online session; information about 
yourself, your product, or your company; and so on.  

At any time, you can replace or delete images and text that you add. 

To add an image to your Personal Meeting Room page: 

1. If you have not already done so, log in to your TrainingCenter website. 

2. On the navigation bar at the top of the page, click MyWebEx. 

3. Click My Profile. The My WebEx Profile page appears. 

4. Under Personal Meeting Room, specify options for your page. 

5. At the bottom of the My WebEx Profile page, click Update. 

SHARING FILES ON YOUR PERSONAL MEETING ROOM PAGE 
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You can share any folders that you create on your My WebEx Files: Folders page so that they appear on the Files tab on your 
Personal Meeting Room page. For any folder that you share, you can specify whether users can download files from or upload 
files to the folder. 

To share files on your Personal Meeting Room page: 

1. Open the My WebEx Files page.  

2. Under Name, locate the folder in which you want to share files.  

3. If the file or folder is in a closed folder, click the folder to open it. 

4. Click the Properties icon for the folder in which you want to share files.   

5. The Edit Folder Properties window appears.  

6. Specify sharing options for the folder. 

7. Click Update. 

 

MAINTAINING F ILES  IN  YOUR PERSONAL FOLDERS  

ABOUT MAINTAINING FILES IN YOUR FOLDERS 

Your user account includes personal storage space for files on your TrainingCenter website.  

In your personal storage space, you can: 

• Create folders to organize your files. 

• Edit information about any file or folder in your personal folders 

• Move or copy a file or folder to a different folder 

• Share a folder so it appears on your Personal Meeting Room page 
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Notes: 
• You can use this storage space to access important information when you are away from the office. For example, if you are on a 

business trip and want to share a file during an online session, you can download the file in your personal folders to a computer, and 
then share the file with attendees. 

• If you share a folder, visitors to your Personal Meeting Room page can upload files to or download them from the folder. For 
example, you can use your personal folders to exchange documents that you share in your sessions, archive recorded meetings, and so 
on.  

OPENING YOUR PERSONAL FOLDERS 

To store files on your meeting service website, or to access files that you stored, you must open your personal folders. 

To open your personal folders:  

1. Log in to your TrainingCenter website, and then click MyWebEx.  

2. Click My Files. 

3. The My WebEx Files age appears, showing your personal folders. 

ADDING NEW FOLDERS TO YOUR PERSONAL FOLDERS 

To organize your files on your meeting service website, you can create folders in your personal storage space for files. 

To create a new folder: 

1. Open the My Folders page.  

2. Under Action, click the Create Folder button for the folder in which you want a new folder.   The Create Folder window 
appears. 

3. In the Folder Name box, type a name for the folder. 

4. Optional: In the Description box, type a description to help you to identify the folder's contents. 

5. Click OK. 
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UPLOADING FILES TO YOUR PERSONAL FOLDERS 

To store files in your personal folders on your TrainingCenter website, you must upload them from your computer or a local 
server.  

You can upload: 

• Up to three files at once 

• Any file that is less than 5076K 

The amount of space available for storing files is determined by your site administrator. If you require more disk space, contact 
your site administrator. 

To upload files to your personal folders: 

1. Locate the folder in which you want to store the file. 

2. Under Action for the folder, click the Upload button for the folder in which you want to store the file.  The Upload File 
window appears. 

3. Click Browse. The Choose File dialog box appears. 

4. Select the file that you want to upload to your folder. 

5. Click Open. 

6. The file appears in the File name box. 

7. Optional: In the Description box, type a description to help you to identify the file. 

8. Optional: Select up to two additional files to upload. 

9. Click Upload. 

10. The files are uploaded to the folder that you selected. 

11. Once you are finished uploading files, click Finish. 

MOVING OR COPYING FILES OR FOLDERS IN YOUR PERSONAL FOLDERS 

In your personal folders on your TrainingCenter website, you can move one or more files or folders to another folder. 

To move or copy a file or folder: 

1. Open the My Folders page.  

2. Locate the file or folder that you want to move. 

3. Select the check box for the file or folder that you want move. 

4. You can select multiple files or folders. 

5. Click Move or Copy. 

6. The Move/Copy File or Folder window appears, showing a list of your folders. 

7. Select the option button for the folder in which you want to move or copy the file or folder. 

8. Click OK. 

EDITING INFORMATION ABOUT FILES OR FOLDERS IN YOUR PERSONAL FOLDERS 

You can edit the following information about a file or folder in your personal folders on your TrainingCenter website: 
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• Name 

• Description 

You can also specify sharing options for folders that appear on your Personal Meeting Room page.  

To edit information about a file or folder: 

1. Open the My Folders page.  

2. Locate the file or folder for which you want to edit information. 

3. Click the Properties icon for the file or folder for which you want to edit information.   The Edit File Properties or Edit 
Folder Properties window appears.  

4. In the Description box, type a new name for the file or folder. 

5. In the Name box, type a new name for the file or folder. 

6. Click Update. 

SEARCHING FOR FILES OR FOLDERS IN YOUR PERSONAL FOLDERS 

In your personal folders on your TrainingCenter website, you can quickly locate a file or folder by searching for it. You can 
search for a file or folder by text that appears in either its name or description. 
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To search for a file or folder: 

1. Open the My Folders page.  

2. In the Search For box type all or part of the file's name or description. 

3. Click Search. 

4. A list of any files or folders that contain the search text appears. 

DOWNLOADING FILES IN YOUR PERSONAL FOLDERS 

In your personal folders on your TrainingCenter website, you can download any files to your computer or a local server. 

To download files: 

1. Open the My Folders page.  

2. Locate the file that you want to download. 

3. Under Action, click the Download button for the file that you want to download.  The File Download dialog box appears. 

4. Follow any instructions that your web browser or operating system provides to download the file. 

DELETING FILES OR FOLDERS IN YOUR PERSONAL FOLDERS 

You can delete any files or folders that reside in your personal folders on your TrainingCenter website. 

To delete a file or folder: 

1. Open the My Folders page.  

2. Under Name, locate the file or folder that you want to delete.  

3. Select the check box for the file or folder that you want delete. 

4. You can select multiple files or folders. 

5. Click Delete. A message appears, asking you confirm that you want to delete the file or folder. 

6. Click OK. 

 

ABOUT THE MY WEBEX  F I LES  PAGE 

How to access this page 

On your TrainingCenter website, click MyWebEx > My Files. 

What you can do here 

• Store files that you use in your online sessions or that you want to access when away from your office. 

• Specify in which folders visitors to your Personal Meeting Room can download or upload files. 

Options on this page 

 Link or Option Description 
Capacity  The storage space available for your files, in megabytes (MB). 
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Used  The amount of storage space that your files occupy, in megabytes (MB). Once this value exceeds your 
capacity, you can no longer store files until you remove existing files from your folders. 

Free The amount of storage space that is available either in your personal storage space or on your entire site, 
depending on the configuration of your site. 

Search for  
Lets you locate a file or folder by searching for it. You can search for a file or folder by text that appears in 
either its name or description. To search for a file or folder, type all or part of it's name or description in the 
box, and then click Search. 

Go Back  Returns you to the page that you previously accessed. 

 
Refresh  

Click this button to refresh the information on the page. 

Name  

The name of the folder or file. Click a folder or file name to open the Folder Information page or File 
Information page. From the Information page, you can access the properties of a folder or file. 

 Indicates that the item is a folder. Click the image to display the contents of the folder. 

 Indicates that the item is a file. 

Path  The folder hierarchy for the folder or file. The Root folder is the top-most folder in which all other folders 
and files reside. 

Size  The size of the folder or file, in kilobytes (KB). 

Actions  

Click the icons to perform an action on the folder or file that is associated with it: 

 Upload file: Available only for files. Click this icon to open the File Upload page, on which you can 
select up to three files at a time to upload to a specified folder. 

 Download file: Available only for files. Click this icon to download the file associated with it. 

 Edit File Properties or Edit Folder Properties: Click this icon to open the Edit File Properties 
page or Edit Folder Properties page, on which you can edit information about the file or folder, respectively. 

 Create Folder: Available for folders only. Click this icon to open the Create Folder page on which 
you can create a new folder in your personal storage space. 

Shared  

Specifies the sharing settings for a folder that is, how others who visit your Personal Meetings Room can 
access your folder and its files.  
R:  Read only: Visitors to your Personal Meeting Room can view the list of files in the folder and download 
the files. 
W:  Write only: Visitors to your Personal Meeting Room can upload files to the folder, but they cannot view 
the files in it. 
R/W:  Read and write: Users can view files in the folder, download files from the folder, and upload files 
to the folder. 

 Password Protected: Indicates that the folder is password protected. Visitors to your Personal 
Meeting Room must provide the password you specify to access the folder. 

Select All  Selects the check boxes for all the folders and files that are visible in the list. You can then click the Copy or 
Move button or click the Delete link to perform an action on the selected folders or files. 

Clear All  Clears the check boxes for all the folders and files that are selected in the list. 
Delete  Deletes the selected folders and files from the list. 
Copy  Opens a page on which you can copy the selected folder or file to another folder. 
Move  Opens a page on which you can move the selected folder or file to another folder. 

ABOUT THE EDIT  FOLDER PROPERT IES  PAGE 

How to access this page 

On your TrainingCenter website, click MyWebEx > My Files > Properties icon for folder. 

What you can do here 

Specify a name, a description, and sharing options for a folder that you created in your personal folders. 
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Options on this page 

 Use this option... to... 
Name  Enter the name of the folder. 
Description  Enter the description of the folder. 

Share  

Specify who can access this folder. 
Do not share this folder: This folder does not appear on your Personal Meeting Room page. Thus, visitors to 
your page cannot view the folder or access any files in it. 
Share this folder: This folder appears on your Personal Meeting Room. 
The drop-down list specifies which users can access the folder, as follows: 
With all: All visitors to your Personal Meeting Room can access this folder. 
With users with host or attendee accounts: Only visitors to your Personal Meeting Room who have either a 
host account or an attendee account on your meeting service website can access this folder. 
With users with host accounts only: Only visitors to your Personal Meeting Room who have a host account on 
your TrainingCenter website can access this folder. 

Share as  Enter the name for the folder that will appear on your Personal Meeting Room page. 
Read  Let visitors to your Personal Meeting Room view the list of files in the folder and download the files. 
Write  Let visitors to your Personal Meeting Room upload files to the folder but cannot view the files in it. 
Read & write  Let users view files in the folder, download files from the folder, and upload files to the folder. 
Allow files to be 
overwritten  

Let users upload a file with the same name as an existing file in the folder and replace the existing file. If this 
option is not selected, users cannot overwrite any files in the folder. 

Password protected  

Let only visitors to your Personal Meeting Room who know the password view the list of files in the folder, 
download files from the folder, or upload files to the folder, depending on the read/write settings for the 
folder. 
Password: The password that visitors to your Personal Meeting Room must provide to access the folder. 
Confirm: If you specified a password, type it again to verify that you typed it correctly. 

Update  Save any changes that you made to folder's properties, and then closes the Edit Folder Properties window. 
Cancel  Close the Edit Folder Properties window, without saving any of the changes that you made. 

 

MAINTAINING CONTACT INFORMATION 

ABOUT MAINTAINING CONTACT INFORMATION 

You can maintain a personal online address book, in which you can add information about contacts and create contact groups. 
When scheduling a training session, you can quickly invite any contacts or contact groups in your personal address book. You 
can also invite contacts in the company address book for your TrainingCenter website, if one is available. 

You can add contacts to your address book in any of the following ways: 

• Specify information about contacts one at a time. 

• Import contact information from your Microsoft Outlook contacts.  

• Import contact information from a comma-separated/comma-delimited values (CSV) file in which you add contact 
information. 

You can also edit or delete the information about any contact or contact group in your personal address book. 

OPENING YOUR ADDRESS BOOK 

You can open your personal address book on your TrainingCenter website, to view or maintain information about your contacts. 

To open your address book: 

1. Log in to your TrainingCenter website.  
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2. On the navigation bar at the top of the page, click MyWebEx. 

3. Click My Contacts. The My Contacts page appears. 

4. In the View drop-down list, select one of the following contact lists: 

a. Personal Contacts: Includes any individual contacts that you added to your personal address book. If you have a 
Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.  

b. My Groups: Includes any contact groups that you have added to your personal address book. 

c. Company Address Book: Your organization's address book, which includes any contacts that your site 
administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site 
administrator can import its contacts to this address book. 

ADDING A CONTACT TO YOUR ADDRESS BOOK 

You can add contacts to your personal address book, one at a time. 

To add a contact to your personal address book: 

1. Open your address book.  

2. In the View drop-down list, select Personal Contacts. 

3. A list of contacts in your personal contacts list appears. 

4. Click Add Contact. The Add Contact page appears. 
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5.  Provide information about the contact.  

6. Click Add. 

Notes: 

• You cannot add contacts to your company address book. 

• If you want to add multiple contacts, you can them all at once, instead of adding one contact at a time.  

ABOUT THE NEW/EDIT CONTACT PAGE 

How to access this page 

On your TrainingCenter website, click MyWebEx > My Contacts > Add Contact > Edit. 

What you can do here 

Enter information about a new or existing contact for your personal address book. 
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Options on this page 

 Use this option... to... 
Get Map  Open the Yahoo! Maps page on the Yahoo! website, to obtain directions to a contact's address. 
Full name  Enter the contact's first and last name. 
Email address  Enter the contact's email address. 

Language  

Set the language in which any email messages that you send to the contact using your 
TrainingCenter site appear. 
Available only if your TrainingCenter website can be displayed in two or more languages.   
Please contact your sales representative for more information on multiple language capabilities. 

Company  Enter the company or organization for which the contact works. 
Job title  Enter the contact's position in a company or organization. 
URL  Enter the URL, or web address, for the contact's company or organization. 
Phone number / Phone number 
for mobile device / Fax number  Enter the contact's phone numbers. For each number, you can specify the following: 

Country Code  
Specify the number that you must dial if the contact resides in another country. To select a 
different country code, click the link to display the display the Country Code window. From the 
drop-down list, select the country in which the contact resides. 

Area or city code  Enter the area or city code for the contact's phone number. 
Number  Enter the phone number. 
Extension  Enter the extension for the phone number, if any. 
Address 1  Enter the contact's street address. 
Address 2  Enter additional address information, if necessary. 
State/Province  Enter the contact's state or province. 
ZIP/Postal code  Enter the contact's ZIP or postal code. 
Country  Enter the country in which the contact resides. 

User name  Enter the user name with which the user logs in to your TrainingCenter website, if the contact has 
a user account. 

Notes  Enter any additional information about the contact. 

IMPORTING CONTACT INFORMATION IN A FILE TO YOUR ADDRESS BOOK 

You can add information about multiple contacts simultaneously to your personal address book, by importing a comma-
separated/comma-delimited (CSV) file. A CSV file has a .csv extension.  

First, create a comma separated values (CSV) file and add contact information to it, using a spreadsheet program, such as 
Microsoft Excel. Next, import the CSV file that you created to your address book. 

To create a CSV file: 

1. Open your address book.  

2. In the View drop-down list, ensure that Personal Address Book is selected. 

3. Click Export. 

4. Save the .csv file to your computer. 

5. Open the .csv file that you saved in a spreadsheet program, such as Microsoft Excel. 

6. Optional: If contact information exists in the file, you can delete it. 

7. Specify information about the new contacts in the .csv file. 

Note: If you add a new contact, ensure that the UID field is blank. 

8. Save the .csv file. Ensure that you save it as a .csv file. 

To import a CSV file containing new contact information: 
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1. Open your address book.  

2. In the View drop-down list, ensure that Personal Address Book is selected. 

3. In the Import From drop-down list, select Comma Delimited Files. 

4. Click Import.  

5. Select the .csv file in which you added new contact information. 

6. Click Open. 

7. Click Upload File. 

8. The View Personal Contacts page appears, allowing you to review the contact information you are importing. 

9. Click Submit. 

10. A confirmation message appears. 

11. Click Yes. 

ABOUT THE CONTACT INFORMATION CSV TEMPLATE 

How to access this template 

On your TrainingCenter website, click MyWebEx > My Contacts > View > Personal Address Book > Export. 

What you can do here 

Specify information about multiple contacts, which you can then import to your personal address book. 

Fields in this template 

Option Description 
UUID  A number that your TrainingCenter site creates to identify the contact. If you add a new contact to the CSV file, you 

must leave this field blank. 
Name  Required. The contact's first and last name. 

Email  Required. The contact's email address. The email address must be in the following format: 
name@company.com  

Company  The company or organization for which the contact works. 
JobTitle  The contact's position in a company or organization. 
URL  The URL, or web address, for the contact's company or organization. 

OffCntry  The country code for the contact's office phone--that is, the number that you must dial if the contact resides in 
another country. 

OffArea  The area or city code for the contact's office phone number. 
OffLoc  The contact's office phone number. 
OffExt  The extension for the contact's office phone number, if any. 

CellCntry  The country code for the contact's cellular or mobile phone--that is, the number that you must dial if the contact 
resides in another country. 

CellArea  The area or city code for the contact's cellular or mobile phone number. 
CellLoc  The contact's cellular or mobile phone number. 
CellExt  Thee extension for the contact's cellular or mobile phone number, if any. 

FaxCntry  The country code for the contact's fax number--that is, the number that you must dial if the contact resides in 
another country. 

FaxArea  The area or city code for the contact's fax number. 
FaxLoc  The contact's fax number. 
FaxExt  The extension for the contact's fax machine, if any. 
Address 1  The contact's street address. 
Address 2  The additional address information, if necessary. 
State/Province  The contact's state or province. 
ZIP/Postal  The contact's ZIP or postal code. 
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Option Description 
Country  The country in which the contact resides. 
Username  The user name with which the user logs in to your TrainingCenter website, if the contact has a user account. 
Notes  Any additional information about the contact. 

IMPORTING CONTACT INFORMATION FROM OUTLOOK TO YOUR ADDRESS BOOK 

If you use Microsoft Outlook, you can import the contacts that you maintain in your Microsoft Outlook address book or folder to 
your personal address book on your TrainingCenter website.  

To import contacts from Outlook to your personal address book: 

1. Open your address book.  

2. In the View drop-down list, select Personal Contacts. 

3. Click Import. The Choose Profile dialog box appears. 

4. In the Profile Name drop-down list, select the Outlook user profile that includes the contact information that you want to 
import. 

5. Click OK. 

Notes: 

• When you import contacts in Outlook, your TrainingCenter website retrieves contact information from the Outlook address book or 
folder in which you have chosen to keep personal addresses.  

• If your personal address book already includes a contact that is also in your Outlook contacts list, the contact is not imported. 
However, if you have changed the contact's email address in your personal address book, importing the contact from Outlook creates 
a new contact in your personal address book. 

VIEWING AND EDITING CONTACT INFORMATION IN YOUR ADDRESS BOOK 

In your personal address book, you can view and edit information about individual contacts in your Personal Contacts list. You 
can view, but not edit, information about contacts in your company address book. 
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To view or edit contact information: 

1. Open your address book.  

2. In the View drop-down list, select one of the following: 

a. Personal Contacts  

b. Company Address Book  

A list of contacts appears. 

3. Locate the contact whose information you want to view or edit.  

4. Under Name, select the contact whose information you want to view or edit. 

5. Do one of the following: 

a. If you the contact is in your personal contacts list, click Edit. 

b. If the contact is in your company address book, click View Info. 

6. Information about the contact appears. 

7. Optional: If the contact is in your personal contacts list, edit the information that you want to change on the Edit Contact's 
Information page. 

8. Click OK. 

SEARCHING FOR CONTACTS IN YOUR ADDRESS BOOK 

You can quickly locate a contact in your personal address book, using one of several methods. 

To search for a contact in your address book: 

1. Open your address book.  

2. In the View drop-down list, select a contacts list.  

3. Do any of the following: 

a. In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, 
the name Susan Jones appears under S. 

b. To search for a contact in the list you are currently viewing, type text that appears in either the contact's name or email 
address in the Search for box, and then click Search.  
If the entire list of contacts does not fit on a single page, view another page by clicking the links for the page numbers. 

c. Sort your personal contacts or company address book by name, email address, or phone number by clicking the column 
headings. 

CREATING A CONTACT GROUP IN YOUR ADDRESS BOOK 

You can create contact groups for your personal address book. A contact group includes two or more contacts for which you 
provide a common name. For example, you can create a contact group named Sales Department , which includes contacts who 
are members of the department. If you want to invite members of the department to a training session, you can select the group 
rather than each member individually. 
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To create a group: 

1. Open your address book.  

2. In the View drop-down list, select My Groups.  A list of any groups that you have already created appears. 

3. Click Add Group. 

4. The New Group page appears. This page includes a list of all the contacts in your personal contacts list in your address 
book. 

5. In the Name box, type the name of the group. 

6. Optional: In the Notes box, type descriptive information about the group. 

7. Under Contacts to add to the group, select the check box for each contact that you want to add to the group.  

8. Click OK. 

EDITING A CONTACT GROUP IN YOUR ADDRESS BOOK 

You can add or remove contacts from any contact group that you have created for your personal address book. You can also 
change a group's name or descriptive information. 

To edit a contact group: 

1. Open your address book.  

2. In the View drop-down list, select My Groups. A list of any groups that you have created appears. 

3. Under Group name, select the check box for the group that you want to edit. 
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4. Click Edit. The Edit Group page appears. This page includes a list of all the contacts in your personal address book. 

5. Under Contacts to add to the group, a check mark appears in the Name column for each contact who is a member of the 

group. 

6. Enter new information about the group 

7. Click OK. 

DELETING CONTACT INFORMATION IN YOUR ADDRESS BOOK 

You can delete any contact or contact groups that you have added to your personal address book. 

To delete a contact or contact group: 

1. Open your address book.  

2. In the View drop-down list, select one of the following: 

a. Personal Contacts  

b. My Groups  

3. In the list that appears, select the check box for the contact or contact group that you want to delete. 

4. Click Delete. A message appears, asking you to confirm the deletion. 

5. Click OK. 
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MAINTAINING YOUR USER  PROFILE  

ABOUT MAINTAINING YOUR USER PROFILE 

Once you obtain a user account, you can edit your user profile at any time to change the following information:  

• Your full name 

• Your user name, if your site administrator provides this option 

• Your password 

• Your contact information, including your street address, email address, and phone numbers 

• Your teleconference account numbers, if your site includes the teleconference account option.   

Note:  InterCall recommends using alternative audio conference services such as Operator-Assisted or Direct Event for the audio portion 
of your session if you have more than 125 participants in your session.  Reservationless-Plus is scalable to 125 participants and is not 
designed for large scale trainings.  Please contact your sales representative for more information on InterCall’s event audio services.  For 
more information on audio controls, please reference the InterCall Centers Audio Controls User Guide and Release Notes on 
www.intercallcenters.com. 

• Tracking codes that your organization uses to keep records of your training sessions, such as project, department, and 
division numbers  

• Personal Meeting Room options, including the images and welcome message that appear on the page 

• Default options for your online sessions, including 

o Whether your scheduled training sessions are automatically removed from your list of meetings once the training 
session ends 

o The default session type that you want to use, if your account includes multiple session types 

o Whether the QuickStart page appears in the content viewer once you start a training session 

o The users who can schedule training sessions on your behalf 

EDITING YOUR USER PROFILE 

Once you obtain a user account, you can edit your user profile at any time to change account login information, contact 
information, and other options available for your account. 
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To edit your user profile: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, click MyWebEx. 

3. Click My Profile. The My Profile page appears. The following page is an example only. Your My Profile page may include 
different options. 

4.  Edit the information on the page. 

5. When you are finished editing your user profile, click Update. 

ABOUT THE MY WEBEX PROFILE PAGE 

How to access this template 

On your TrainingCenter website, click MyWebEx > My Profile. 

What you can do here  

Specify the following: 

• Account information 

• Personal information 

• Personal Meeting Room information 

• Teleconference Account information 

• Session options 
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Personal information options 

Use this option.... to.... 

User name  

Specify the user name for your account. You can change this name only if the administrator for your 
TrainingCenter website provides this option. 
If you need to change your user name, but cannot edit it on this page, ask your site administrator to 
change your user name or create a new account for you. 

Password  

Specify the password for your account. A password: 
Must contain at least four characters 
Can consist of a maximum of 32 characters 
Can include any letters, numbers, or special characters, but not spaces 
Is case sensitive 

Confirm password  Verify that you typed your password correctly in the Password box. 
Other personal 
information options  Enter any personal information that you want to maintain in your profile. 

Personal Meeting Room options 

Use this option.... to.... 

Personal Meeting Room 
URL  

Go to your Personal Meeting Room page. 
Your Personal Meeting Room page lists any online sessions that you scheduled and any in-progress 
sessions that you are currently hosting. 
Users to whom you provide your personal URL can use this page to join any training session that you 
are hosting. They can also download files in any folders that you share. 

Welcome Message  
Enter the message that appears on your Personal Meeting Room page. A message can be a maximum 
of 128 characters, including spaces and punctuation. 
To specify a message, type it in the box, and then click Update . 

Upload Image  

Upload an image file which resides on your computer or another computer on your network to your 
Personal Meeting Room page. For example, you can upload a picture of yourself, your company's 
logo, or a picture of your company's product. Visitors to your page can see the image that you upload. 
The image can be an maximum of 160 pixels wide. If you upload a larger image, its width is 
automatically reduced to 160 pixels. However, the image's aspect ratio is maintained. 
Browse: Lets you locate an image. 
Upload: Uploads the image that you selected. 
Current Image: Displays the image that currently appears on your Personal Meeting Room page. 
Delete: Removes the current image from your Personal Meeting Room page. This button is available 
only if you have uploaded an image for the page. 

Customize branding of 
header area  

Upload a "banner" image to the non-scrolling header area for your Personal Meeting Room page. For 
example, you can upload your company's logo or an advertisement. Visitors to your page can see the 
image that you upload. Available only if your site administrator has turned on this option for your 
account. 
The image can be an maximum of 75 pixels high. If you upload a larger image, its height is 
automatically reduced to 75 pixels. However, the image's aspect ratio is maintained. 
Browse: Lets you locate a banner image. 
Upload: Uploads the banner image that you selected. 
Current Image: Displays the banner image that currently appears on your Personal Meeting Room 
page. 
Delete: Removes the current banner image from your Personal Meeting Room page. This button is 
available only if you have uploaded an image for the page. 

Session options 

Use this option.... to.... 

Default session type  

Specify the default session type that you host, if your user account lets you host different types of 
online sessions. 
For more information about session types, ask the site administrator for your WebEx service. 
You can change this default setting when scheduling a training session. 

QuickStart  Specify whether the QuickStart page appears in the content viewer once you start a training session. 



G
L

O
B

A
L

 C
O

N
F

E
R

E
N

C
IN

G
 S

O
L

U
T

IO
N

S
 

 
 
 

 WWW.INTERCALL.COM   1-800-374-2441

AAP/EOE 
Last Rev.  12.18.06 

WebExTM and  MyWebExTM are either registered trademarks or 
trademarks of WebEx Communications Inc. in the United States 
and other countries. 

The QuickStart lets you start sharing activities quickly, as an alternative to starting them from a menu 
or toolbar. 
Show QuickStart to host and presenter: The QuickStart appears in the content viewer for the host and 
presenter. 
Show QuickStart to attendees: The QuickStart appears in the content viewer for attendees. Select this 
option only if you intent to let attendees share information during your training sessions. 
You can change this default setting when scheduling a training session. 

Scheduling permission  

Type the email addresses for any users whom you want to let schedule training sessions for you. 
Separate email addresses with either a comma or a semicolon. 
Select From Host List: Open the Select Host page, which contains a list of all users who have accounts 
on your TrainingCenter website. On this page, you can select users whom you want to let schedule 
training sessions for you. 

 

GENERATING REPORTS  

ABOUT GENERATING REPORTS 

If your user account includes the reports option, you can view the following types of usage reports: 

General Meeting Usage reports 

These reports contain information about each online session that you host. You can view the following types of Meeting Usage 
reports: 

• Summary Usage report: Contains a summary of the information about each training session, including the topic, date, 
starting and ending time, duration, number of attendees you invited, number of invited attendees who actually attended, and 
type of voice conferencing you used. 

• Summary Usage report CSV (comma-separated values) file: Contains additional details about each training 
session, including the "people minutes" (cumulative number of minutes that all participants were connected to the meeting) 
and tracking codes. 

• Session Detail report: Contains detailed information about each participant in a training session, including the time the 
participant joined and left the training session and any information that the attendee provided. 

Access Anywhere usage report 

This report contains detailed information about the computers that you access remotely, including the date on which you accessed 
your remote computer and the starting and ending times of your session. 
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TrainingCenter reports 

These reports contain detailed information about the training sessions you host. You can view the following types of 
TrainingCenter reports: 

• Live Training Usage report: The Live Training Usage report is available in two formats: 

o Live Training Usage Summary report: Contains a summary of the information about each training session, 
including the topic, date, starting and ending time, duration, number of attendees you invited, number of attendees 
who registered, and number of invited attendees who actually attended. 

o Live Training Usage Detail report: Contains detailed information about each attendee in a training session, 
including the time the participant joined and left the meeting and any information that the attendee provided, such 
as registration information. You can also view information about any registrants who did not attend a session. 

• Recorded Training Access report: Contains access and registration information about each recorded training session 
that you published on your TrainingCenter website. 

GENERATING USAGE REPORTS 

You can generate usage reports that provide information about each online session that you have hosted on your site. 

You can export or download the data in many types of reports to a comma-separated values (CSV) file, which you can open in a 
spreadsheet program, such as Microsoft Excel. You can also print reports in a printer-friendly format. 

To generate a usage report: 

1. Log in to your TrainingCenter website, and then click MyWebEx. 

2. Click My Reports. The My Reports page appears. 

3. Choose the type of report you want to generate. 

4. Specify your search criteria, such as a date range for which you want to view data in the report. 

5. Generate the report. 

 

SETT ING WEBSITE  PREFERENCES 
  

ABOUT SETTING WEBSITE PREFERENCES 

You can customize your TrainingCenter website by specifying the following preferences: 

• The home page that appears when you access your TrainingCenter website 

• The time zone in which training session times appear 

• The language in which your website displays text, if your site includes multiple languages 

• The locale--that is, the format in which your website displays dates, times, currency values, and numbers 

You need not have a user account to specify preferences for your TrainingCenter website. However, if you log in to your site 
with a user account, more options for choosing a home page are available on the Preferences page. 

SETTING PREFERENCES FOR YOUR TRAININGCENTER WEBSITE 

You can select a default page on your TrainingCenter website that appears whenever you access your site.  
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To preferences for your TrainingCenter website: 

1. Log in to your TrainingCenter website, and then click MyWebEx. 

2. Click Preferences. The Preferences page appears. 

3.  Select your preferences. 

4. Click OK. 

ABOUT THE PREFERENCES PAGE 

How to access this page 

On your TrainingCenter website, click Set Up > Preferences, or click MyWebEx > Preferences. 

What you can do here 

The Preferences page allows you to specify preferences for your TrainingCenter website. 

Options on this page 

Use this option.... to.... 
Home page  Set the first page that appears when you access your TrainingCenter website. 

Time zone  

Set the time zone in which you reside. 
If you select a time zone for which daylight saving time (DST) is in effect, your TrainingCenter website 
automatically adjusts its clock for daylight saving time 
The selected time zone appears: 
Only on your view of your TrainingCenter website, not other users' views  
In all training session invitations that you send using your TrainingCenter website 

Language  Set in which language your TrainingCenter website displays texts. 
The languages that appear in this list are limited to the languages that have been set up for your website. 

Locale  Set the format in which your website displays dates, times, currency values, and numbers. 
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USING SCORM 

SCORM OVERVIEW 

SCORM (Sharable Courseware Object Reference Model) is a set of technical standards allowing web-based learning systems to 
find, import, share, reuse, and export learning content in a standardized way. In SCORM pages, the learning management system 
(LMS) can track what needs to be delivered to the learner, when the learner achieves the skill or competency, and sends the 
learner to the appropriate level of content. 

An Application Programming Interface (API) provides a standard way of communicating with the LMS using web-friendly 
JavaScript. InterCall provides a SCORM page in which the host can specify which information is provided in the API.  

You can read more about SCORM at the following websites: 

• www.adlnet.org   

• www.imsglobal.org   

• www.rhassociates.com/scorm.htm   

• www.teleologic.net/SCORM/index.htm   

• www.altrc.org/specifications.asp   

Please contact your sales representative for more information on APIs and how to connect your LMS to the TrainingCenter 
application. 

VIEWING THE SCORM PAGE 

To view SCORM data for a scheduled training session from your personal training calendar on your TrainingCenter website, 
follow these steps: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, click MyWebEx.  The My Meetings page appears, showing a list of any training sessions that you 
have scheduled. 

3. In the list of training sessions, click the link for the training session that you want to view.  The Session Information page 
appears. 
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4. Click a link next to SCORM data.  The Edit SCORM Information page appears. 

5. To download the file, click Save and Download. Follow the instructions in the File Download dialog box. 

EDITING THE SCORM PAGE 

To edit SCORM data for a scheduled training session from your personal training calendar on your TrainingCenter website, 
follow these steps: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, click MyWebEx. 
The My Meetings page appears, showing a list of any training sessions that you have scheduled. 

3. In the list of training sessions, click the link for the training session that you want to view.  The Session Information page 
appears. 

4. Click a link next to SCORM data. The Edit SCORM Information page appears. 

5. Make your changes in the text boxes, and select your options in the drop-down lists. 
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6. When you have finished editing, click Save to save your changes. 

7. To download the file, click Save and Download. Follow the instructions in the File Download dialog box. 

 

SETT ING UP A  ONE-CL ICK MEET ING 

ABOUT SETTING UP A ONE-CLICK MEETING 

A One-Click Meeting lets you quickly and easily start a training session at any time, with just a single click of your mouse. Use 
your One-Click Meeting whenever you want to meet with others instantly. 

To set up a One-Click Meeting, you use the One-Click Meeting Wizard, which asks you to specify the options you want for your 
training session. You can specify a password, set up a voice conference, assign attendee privileges, and so on. Once you complete 
this simple, one-time setup, you can start your One-Click Meeting whenever you want--as often as you want--without having to 
set up the training session again. 

You can start your One-Click Meeting from the navigation bar on your TrainingCenter website, or by clicking a shortcut on your: 

• Desktop  

• Web browser toolbar  

• WebEx menu in Microsoft Office applications  

• Right-click menu for any file or application icon  

At any time, you can return to the One-Click Meeting Wizard to quickly change any details about your One-Click Meeting, as 
well as which shortcuts you want to download. 

Note: Because you do not schedule a One-Click Meeting, you cannot invite attendees to a training session before you start it. However, you can 
send them an invitation after you start the training session. 

SETTING UP A ONE-CLICK MEETING 

The Set Up One-Click Meeting Wizard guides you through the process of setting up a One-Click Meeting. You can return to the 
wizard at any time to modify your training session. 

To set up a One-Click Meeting: 

1. Log in to your TrainingCenter website.  

2. Do either of the following: 

a. Click MyWebEx > Set Up One-Click. 
If you already set up a One-Click Meeting previously, click MyWebEx > One-Click Meeting. 

b. On the navigation bar, click Set Up > One-Click Meeting. 

3. Provide training session information in the One-Click Meeting Wizard.  

4. Optional: Click Download shortcuts, and then choose the One-Click Meeting Shortcuts you want to install. 
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ABOUT THE ONE-CLICK MEETING WIZARD 

How to access this page:  

On your TrainingCenter website, click MyWebEx > Set Up One-Click or One-Click Meeting tab. 

What you can do here: 

Set options for a training session, and then create a shortcut on your computer that you can click to start the training session at 
any time. 

Topic, Service Type, and Access  

Use this option... to... 
Topic  Specify the topic, or name, for the training session 
Set meeting 
password  Specify the password for the training session. 

Confirm password  Type the password again to prevent typing errors. 
Listed for all  Specify that the training session appears for any users who visit the Live Sessions page on your site. 
Listed for 
authorized users 
only  

Specify that the training session appears on the Live Sessions page for only users who have user accounts and 
have logged in to your site. 

Unlisted  

Specify that the training session does not appear on the Live Sessions page on your site. An unlisted training 
session prevents anyone from viewing information about the session, such as its host, topic, and starting time; 
and helps to prevent unauthorized access to the session. To join an unlisted training session, an attendee must 
provide a unique meeting number. 

Service type  Select the type of online session for which you want to create a One-Click Meeting. This option lists only the 
session types available for your site and user account. 

Tracking Codes   

Use this option... to... 

Tracking code  

Identify your department, project, or other information that your organization wants to associate with your 
training sessions. Tracking codes can be optional or required, depending on how your site administrator set 
them up.  
If your site administrator requires you to select a code from a predefined list, click the link Select Code, and 
then select a code from the list.  

Voice Conference Setup  

Use this option... to... 
Teleconference  Select the type of audio conference you would like to use: 
  None: Specifies that the training session does not include an audio conference. 

  Other teleconferencing service: Provides space for you to type instructions to join your InterCall audio 
conference. 
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Meeting Options  

Use this option... to... 
Save:  Let attendees save any shared documents, presentations, or whiteboards that appear in their content 

viewers 

Print  Let attendees print any shared documents, presentations, or whiteboards that appear in their content 
viewers 

Annotate  
Let attendees annotate any shared documents or presentations, or write and draw on shared 
whiteboards that appear in their content viewers, using the toolbar that appears above the viewer. An 
attendee's annotations are visible to all participants. 

Attendee list  Let attendees see the list of all attendees on the Participants panel. 
Video  Make the Video panel is available during the session. 

Thumbnails  

Let attendees display miniatures of any pages, slides, or whiteboards in any document, presentation, 
or whiteboard that appear in their content viewers. 
However, attendees with this privilege cannot display a miniature at full size unless they also have 
the Next or previous page privilege. 

Next or previous page  Let attendees view any pages, slides, or whiteboards that appear in their content viewers. This 
privilege allows attendees to navigate independently through pages, slides, or whiteboards. 

Chat  Make the Chat panel available during the session.  

File transfer  Make the File Transfer option available during the session, This option lets the presenter publish files 
during the session, which attendees can download to their computers. 

Recording  Make recording options available during the session--that is, the host and presenter can record the 
session, and attendees can record the session if they have recording privileges. 

Exclude password from 
email invitation  

Prevent the session password from appearing in email invitations, if you invite attendees using the 
Invite by Email option during the session. In this case, you must provide the password to attendees 
by another means, such as by phone. 

Attendees must have an 
account on this service to 
attend session  

Require that all attendees must have a user account on your site to attend the session. The account 
can be either a host or attendee account. 

Allow attendees to share 
UCF objects  

Let attendees share Universal Communications Format (UCF) media files during the session, either 
in a UCF multimedia presentation or as standalone UCF media files. A session host who is also the 
presenter can always share UCF media files, whether or not you select this check box. 

Download One-Click Shortcuts  

Link or option Description 
On my desktop  Adds a shortcut to your One-Click Meeting on your computer's desktop. 

On my web browser  

Adds a shortcut to your One-Click Meeting on your web browser's button toolbar. Available for Microsoft 
Internet Explorer only. 
If you previously customized your Internet Explorer toolbar, the shortcut button does not automatically 
appear on the toolbar. Instead, it is added to the list of available toolbar buttons in Internet Explorer. In 
this case, you must add the button to the toolbar, using the Internet Explorer Customize option. To access 
this option, on the View menu, point to Toolbars, and then choose Customize. 
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STARTING A ONE-CLICK MEETING 

If you set up a One-Click Meeting, you can start it at any time, by clicking the shortcuts that you downloaded when setting up the 
meeting. Depending on the shortcuts that you downloaded, you can start a One-Click Meeting from: 

• Your computer's desktop 

• Your web browser (Internet Explorer only) 

You can also start your meeting by clicking the One-Click Meeting link on the navigation bar on your TrainingCenter site. 

If you did not already download shortcuts for your One-Click Meeting, you can download them at any time.  

To start a One-Click Meeting, click a shortcut that you downloaded: 

Shortcut Description 

  

Desktop shortcut: Double-click this shortcut to start your meeting. 

  

Web browser shortcut: Click this icon to start your meeting. 

Note: Once you start a One-Click Meeting, it appears on your Personal Meeting Room page. If you provide others with the URL for this page, 
they can quickly join your meeting by clicking the link for the meeting on this page.  

REMOVING ONE-CLICK MEETING SHORTCUTS 

If you downloaded shortcuts for your One-Click Meeting, you can remove them at any time.  

To remove One-Click Meeting shortcuts from your computer: 

1. Open the Windows Add/Remove Programs utility on your computer. 

2. Select WebEx One-Click Shortcuts or WebEx One-Click Meeting, depending on how you installed the program. 

3. Select the option to remove the program. 

4. Follow the instructions on your screen. 
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START ING,  MODIFY ING OR CANCEL ING A TRAINING SESS ION 

STARTING AN INSTANT TRAINING SESSION 

If your TrainingCenter website includes the instant training session option, you can start a training session at any time, without 
the need to schedule it first.  

Once you start an instant training session, you can optionally invite attendees. Each invited attendee receives an invitation email 
message that includes information about the training session and a link that the attendee can click to join the training session. 

To start an instant training session: 

1. Log in to your TrainingCenter website. 

2. On the navigation bar, expand Host a Session to view a list links. 

3. Click Instant Session. The Start an Instant Training Session page appears. 

4. Type the training session's topic in the Topic box. 

5. Type a password for the training session in the Set Session Password and Confirm password boxes. A valid password 
should contain at least 6 characters.  Attendees must provide this password to join the training session. 

6. Specify whether the training session is listed or unlisted on the list of sessions and the training session calendar.  

7. Optional: To include audio conference information, select the Other Teleconference check box. 

8. Click Start Session. 

9. Click OK. 

10. If you haven't already set up TrainingCenter on your computer, the Set Up TrainingCenter page appears. Click Set Up.  

11. If your TrainingCenter requires that you provide tracking information for the training sessions that you host, do one of the 
following for each option on the Tracking Codes page that appears: 

a. Type a code or other text in the box. 

b. If your site administrator requires you to select a code from a predefined list, you cannot type text in the box.  

c. If a predefined list of codes is available, click the code's label, then, in the list that appears, select a code. Click OK. 

The Session window appears, and the Join Teleconference dialog box appears. 

12. Follow the instructions in the dialog box to join the audio conference. 

13. Optional: After starting the session, invite attendees to the training session by sending them invitation email messages that 
include instructions for joining the training session.  
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STARTING A SCHEDULED TRAINING SESSION 

Training Sessions do not start automatically at scheduled times. As the training session host, you must first start a training 
session, and then attendees can join the session. You can start a training session that you scheduled at its starting time, or any 
time before or after that time.  

Once you schedule a training session, you receive a confirmation email message that includes a link that you can click to start the 
session. Or, you can start the training session from your personal sessions page on your TrainingCenter website. 

STARTING A SCHEDULED TRAINING SESSION FROM A CONFIRMATION EMAIL 
MESSAGE 

You can start your training session from the confirmation email message that you receive after you schedule your session. 

To start a training session from the confirmation email message: 

1. Open your confirmation email message, and then click the link. 

2. If you are not already logged in to your TrainingCenter website, the Log In page appears. 

3. If the Log In page appears, provide your user name and password, then click Log In.  The Session Information page appears. 

4. Click Start Now. The Session window appears. 

5. If the training session includes an InterCall audio conference, the Join Teleconference dialog box appears. Follow the 
instructions in the dialog box to start the audio conference. 

STARTING A SCHEDULED TRAINING SESSION FROM YOUR TRAINING SESSIONS PAGE 

You can start your training session from your training sessions page on your TrainingCenter website. 

To start a training session from your training sessions page: 

1. Log in to your TrainingCenter website. 

2. On the navigation bar, click MyWebEx.  The My WebEx Meetings page appears, showing a list of any training sessions 
that you have scheduled. 

3. In the list of training sessions, under Status, click Start for the training session that you want to begin.  The Session 
window appears. 

4. If the training session includes an InterCall audio conference, the Join Teleconference dialog box appears. Follow the 
instructions in the dialog box to start the audio conference. 
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MODIFYING A SCHEDULED TRAINING SESSION 

Once you schedule a training session, you can modify it at any time before you start it--including its starting time, topic, 
password, agenda, and so on.  

If you update any information about a training session, including adding or removing attendees, you can choose to send attendees 
a new invitation email message that informs them that you have modified information about the training session. Attendees 
whom you removed from the attendee list receive an email message informing them that the training session was canceled. 

You can modify a training session from the confirmation email message that you received after you scheduled the session, or 
from your personal sessions page on your TrainingCenter website. 

MODIFYING A SCHEDULED TRAINING SESSION FROM A CONFIRMATION EMAIL 
MESSAGE 

You can modify a training session from the confirmation email message that you received after scheduling a training session.  

To modify a training session from the confirmation email message: 

1. Open your confirmation email message, and then click the link. 

2. If you are not already logged in to your TrainingCenter website, the Log In page appears. 

3. If the Log In page appears, provide your user name and password, and then click Log In.  The Session Information page 
appears. 

4. Click Edit. 

5. Modify the training session. 

6. To save your changes to the training session, click Update. 

7. If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees. 

8. In the message box, click the appropriate update option, and then click OK. 

9. You receive a confirmation email message that includes information about the changes that you made to the training session. 

MODIFYING A SCHEDULED TRAINING SESSION FROM YOUR TRAINING SESSIONS 
PAGE 

You can modify a scheduled training session from your list of sessions on your TrainingCenter website. 

To modify a training session from your training sessions page: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, click MyWebEx. 

3. The My WebEx Meetings page appears, showing a list of any training sessions that you have scheduled. 

4. In the list of training sessions, under Topic, click the topic for the training session. 

5. Click Edit.  

6. Modify the training session.  

7. Click Update. 

8. If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees. 

9. In the message box, click the appropriate update option, and then click OK. 

10. If you click Cancel in the message box, the training session is not updated. 
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11. You will receive a confirmation email message.  

CANCELING A SCHEDULED TRAINING SESSION 

You can cancel any training session that you have scheduled. Once you cancel a training session, you can choose to send a 
cancellation email message to all attendees whom you invited to the training session. Canceling a training session deletes it from 
your list of training sessions. 

You can cancel a training session from the confirmation email message that you received after you scheduled the training session 
or from your list of training sessions under MyWebEx. 

CANCELING A SCHEDULED TRAINING SESSION FROM A CONFIRMATION EMAIL 
MESSAGE 

To cancel a training session from a confirmation email message: 

1. Open your email confirmation message, and then click the link. 

2. If you are not already logged in to your training session website, the Log In page appears. 

3. If the Log In page appears, provide your user name and password, and then click Log In.  The Session Information page 
appears. 

4. Click Edit.  The Edit Scheduled Training Session page appears. 

5. Click Delete, and then click OK to confirm that you want to cancel the meeting.  If you invited attendees, a message 
appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the training 
session. 

6. In the message box, make the appropriate selection and then click OK. 

7. If you click Cancel in the message box, the training session is not canceled. 

8. You will receive a cancellation confirmation email message. 

CANCELING A SCHEDULED TRAINING SESSION FROM YOUR TRAINING SESSIONS 
PAGE 

To cancel a scheduled training session from your training sessions page on your TrainingCenter 
website: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, click MyWebEx.  

3. The My Meetings page appears, showing a list of any training sessions that you have scheduled. 

4. In the list of training sessions, under Topic, select the check box for the training session you wish to delete. 

5. Click Delete, and then click OK to confirm that you want to cancel the meeting.  If you invited attendees, a message 
appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the training 
session. 

6. In the message box, click Yes or No, as appropriate. 

7. If you click Cancel in the message box, the training session is not canceled. 

8. You receive a cancellation confirmation email message. 
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MANAGING A TRAINING SESS ION 

ABOUT MANAGING TRAINING SESSIONS 

You can run a seamless and smooth training session using the features available in TrainingCenter. For instance, you can do the 
following: 

• Invite others, including coworkers, prospective clients, subject matter experts, or managers to join a training session that has 
already started 

• Ask another participant to host the session; if you need to leave unexpectedly, you can rejoin later and reclaim the host role 

• Ask another participant to present materials, such as a presentation, file, spreadsheet or other document 

• Designate an attendee as a panelist to join in discussions and to answer questions 

INVITING ATTENDEES AFTER YOUR TRAINING SESSION STARTS 

You can send an invitation by email to anyone--including those you have not invited previously--after your training session 
starts.  

To send an email invitation: 

1. In the session window on the Participant menu, choose Invite and then by Email.  
The Invite Attendees page appears. 

2. Send email invitations to new attendees or resend invitations to attendees who you previously invited. 

3. To send invitations to new attendees, in the Invite new attendees window, type each attendee's email address in the 
Attendee email addresses box. Click Send Invitation. 

4. To resend invitations to attendees and presenters that you invited when you scheduled the session, in the Re-send 
invitations window, click Re-send Invitation.  

5. If your session requires registration, the invitation emails are only sent to presenters and approved attendees. 

6. Each attendee receives an invitation email message, which includes  

a. a link that the participant can click to join the training session 

b. the training session password, if you specified one 

c. the audio conferencing information 

d. the session number, which the participant must provide if your training session is unlisted and he or she joins the 
training session from your TrainingCenter website, instead of clicking the link in the email message 

DESIGNATING A PRESENTER 
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As the host, you are initially the presenter as well. However, during a training session, you can designate any attendee as the 
presenter. You can also reassume the presenter role or change the presenter at any time.  

Note: Changing the presenter discontinues any application, desktop, or web browser sharing session currently in progress. However, any 
documents, presentations, or whiteboards that the current presenter is sharing remain in the content viewer. 

To designate a presenter: 

1. In the Session window, in the participant list on the Participants & Communications panel, select the name of the attendee 
whom you want to designate as presenter. 

2. Do either of the following: 

a. On the Participants & Communications panel, click the Make Presenter button on the toolbar. 

b. On the Participant menu, point to Change Role To, and then choose Presenter.  The presenter indicator appears 
to the left of the attendee's name, and the attendee assumes the role of presenter.  

To reclaim the presenter role:  

In the participant list, select your name. On the Participants & Communications panel, click the Make Presenter button on 
the panel toolbar. 

DESIGNATING A PANELIST 

During a training session, you can designate any training session attendee as a panelist. You can also change the panelist's role 
back to attendee at any time. 

To designate a panelist: 

1. In the Session window, in the participant list on the Participants & Communications panel the name of the attendee 
whom you want to designate as a panelist. 

2. On the Participant menu, point to Change Role To, and then choose Panelist. 

3. The attendee's name appears in the list of panelists. 

To change the panelist's role back to attendee: 

1. On the Participants & Communications panel, in the panelist list, select the attendee's name. 

2. On the Participant menu, point to Change Role To, and then choose Attendee. 

TRANSFERRING THE HOST ROLE TO ANOTHER PARTICIPANT 

As the host, you can transfer the host role--and thus control of the training session--to another participant at any time. This option 
can be useful if you need to leave the training session for any reason. You can reclaim the host role at any time. 

If you leave a training session--whether intentionally or inadvertently--and then log back in to your TrainingCenter website, you 
automatically become the training session host once you rejoin the training session. You can rejoin a training session using either 
the Live Sessions page or your private Meeting Room page. 

To transfer the host role to an attendee: 

1. Optional: If you plan to reclaim the host role later, write down the host key that appears on the Info tab in the Session 
window's content viewer. 
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2. Click the Participants & Communications panel.  

3. In the participant list, select the name of the attendee to whom you want to transfer the host role. 

4. On the Participant menu, point to Change Role To, and then choose Host. 

5. A confirmation message appears, in which you can verify that you want to transfer control of the training session to the 
attendee whom you selected.  

6. Click OK.  

7. The word (host) appears to the right of the attendee's name in the participant list. 

RECLAIMING THE HOST ROLE 

If an attendee has control of the training session, you can assume control by reclaiming the host role.  

Note: If you leave a training session--whether intentionally or inadvertently--and then log back in to your TrainingCenter website, you 
automatically become the training session host once you rejoin the training session. You can rejoin the training session using your list of 
scheduled training sessions. 

To reclaim the host role: 

1. Click the Participants & Communications panel. 

2. In the participant list, select your own name. 

3. On the Participant menu, choose Reclaim Host Role.  The Reclaim Host Role dialog box appears. 

4. Type the host key in the Host key box. 

5. Click OK.  

6. In the participant list, the word (host) appears to the right of your name. 

Notes: If you did not write down the host key before transferring the host role to another attendee, you can ask the current host to send you the 
host key in a private chat message. The host key appears on the current host's Info tab in the content viewer. 
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OBTAINING INFORMATION ABOUT A TRAINING SESSION AFTER IT STARTS 

During a training session, you can obtain general information about the session, including the following: 

• training session topic 

• location, or URL, of the website on which the training session is occurring 

• training session number  

• audio conferencing instructions 

• current host 

• current presenter 

• current user--that is, your name 

• current number of participants 

To obtain information about a session in progress: 

1. In the Session window, on the Session menu, choose Information. 

2. The Training Session Information dialog box appears listing general information about the training session. 

EDITING A MESSAGE OR GREETING DURING A TRAINING SESSION 

When scheduling a training session, you can create a message or greeting for attendees, and optionally specify that the message 
or greeting automatically appears in attendees' Session windows once they join the training session. During a training session, 
you can edit the message or greeting that you created, or edit the default greeting. 

In your message or greeting, you can welcome the attendee to the training session, provide important information about the 
training session, or provide special instructions. 

To edit a message or greeting during a training session: 

1. In the Session window, on the Session menu, choose Welcome Message. 
The Create an Attendee Greeting page appears. 

2. Optional: Select the Display this message when attendees join the session check box. 

3. The message or greeting automatically appears once the attendee joins the training session. 

4. Type a message or greeting in the Message box. 

5. A message or greeting can contain a maximum of 255 characters. 
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6. Click OK. 

Notes: Attendees can view the message or greeting at any time by choosing Welcome Message on the Session menu. 

RESTRICTING ACCESS TO THE TRAINING SESSION 

Once you start the training session, you can restrict access to it at any time. This option prevents anyone from joining the training 
session, including attendees whom you invited to the training session but have not yet joined it. 

To restrict access to the training session: 

1. In the Session window, on the Session menu, choose Restrict Access. 

2. Attendees can no longer join the training session. 

3. Optional: To restore access to the training session, on the Session menu, choose Restore Access. 

REMOVING AN ATTENDEE FROM THE TRAINING SESSION 

You can remove an attendee from the training session at any time. 

To remove an attendee from the training session: 

1. In the Session window, in the participant list on the Participants & Communications panel, select the name of the attendee 
whom you want to remove from the training session. 

2. On the Participant menu, choose Expel. 

3. A confirmation message appears, in which you can verify that you want to remove the attendee from the training session.  

4. Click Yes. 

5. The attendee is removed from the training session. 

Note: To prevent an expelled attendee from rejoining the training session, you can restrict access to the training session.  

LEAVING THE TRAINING SESSION 

To leave the training session: 

1. In the Session window, on the File menu, choose Leave Training Session. 

2. A confirmation message box appears, in which you can verify that you want to leave the training session. 

3. Click Yes. 

4. The Session window closes. 

ENDING THE TRAINING SESSION 

You can end the training session at any time. Once you end a training session, the Session window closes for all attendees.  

To end the training session: 

1. In the Session window, on the File menu, choose End Training Session . 

2. A confirmation message appears, in which you can verify that you want to end the training session. If you have not yet 
saved an annotated document or presentation, recording, poll questionnaire, poll results, or chat, Training Manager asks you 
whether you want to save it before ending the training session.  

3. Click Yes. 
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4. The Session window closes. 

Note: Alternatively, as the training session host, you can leave a training session without ending it. Before you leave a training session, you 
should first transfer the host role to another attendee. 

 

TRANSFERRING F I LES  DURING A TRAINING SESS ION 

ABOUT TRANSFERRING FILES DURING A TRAINING SESSION 

During a training session, you can publish files that reside on your computer. Training session attendees can then download the 
published files to their computers or local servers. Publishing files is useful if you want to provide attendees with a document, a 
copy of your presentation, an application, and so on.  

Files that you publish reside only on your computer--not on a server. Thus, your published files are always protected from 
unauthorized access during a training session. 

PUBLISHING FILES DURING A TRAINING SESSION 

During a training session, you can publish files that reside on your computer, and training session attendees can download the 
files to their computers or local servers. 

To publish files during a training session: 

1. In the Session window, on the File menu, choose Transfer.   The File Transfer window appears. 

2. Click Share File. The Open dialog box appears. 

3. Select the file that you want to publish. 

4. Click Open. The file appears in the File Transfer window. 

5. The File Transfer window then automatically appears in each attendee's Session window. 

6. Optional: Publish additional files that you want attendees to download. 

Note: The number of attendee Session windows in which the File Transfer window is open, including your own, appears in the lower-right corner 
of the File Transfer window. 

To stop publishing files during a training session: 
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1. In the title bar of the File Transfer window, click the Close button. 

2. Training Manager closes the File Transfer window in each attendee's Session window. 

 

MANAGING HANDS-ON LAB  

ABOUT HANDS-ON LAB 

Hands-on Lab sessions allow instructors to prepare lessons or exercises that students can complete on remote computers on 
which training software is installed. Students can use these remote computers during a training session for hands-on learning and 
practice. Because instructors can control Hands-on Lab sessions, they can maintain an optimized lab environment that is 
effective, familiar, and consistent. 

To set up a Hands-on Lab session, the host schedules the lab and reserves the computers for the presenter. Then the host starts the 
Hands-on Lab within the training session. The presenter assigns computers to participants, connects the computers with a mouse 
click, and then each participant can use the virtual computer at his or her own remote location. The presenter or host can also 

• set recording options for the Hands-On Lab session 

• broadcast a message to all participants 

• respond to a participant's request for help 

• ask all to return from the lab 

• end the Hands-on Lab session 

SETTING UP HANDS-ON LAB 

You can schedule the following two types of Hands-on Lab sessions: 

• In-session Hands-on Lab. 

• On-Demand Hands-on Lab 
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ABOUT THE HANDS-ON LAB PAGE 

To access the Hands-on Lab page, log in to your TrainingCenter website. On the navigation bar, expand Host a Session, and 
then click Hands-on Lab. 

You can do the following from this page: 

Hands-on Labs tab 

• View a list of the Hands-on Lab computers set up by your Hands-on Lab administrator. 

• View the schedule for each of the labs. 

• Reserve computers for on-demand sessions. 

My Reservations tab 

• View the sessions you have scheduled for in-session or on-demand Hands-on Lab. 

• Change your reservations, such as inviting attendees and canceling reservations. 

SETTING UP IN-SESSION HANDS-ON LAB 

In-session Hands-on Lab allows attendees to practice what they learn while they are attending a training session. Attendees gain 
hands-on experience by connecting to remote computers on which training software has been installed. 

To set up in-session Hands-on Lab, first reserve computers in one of the labs when scheduling a training session, and then start 
Hands-on Lab during the training session. 

Note: Hosts reserve in-session Hands-on Lab computers from the same pool of remote computers that hosts reserve for on-demand Hands-on 
Lab. Labs and remote computers are set up by the Hands-on Lab administrator in your organization. 

RESERVING COMPUTERS FOR IN-SESSION HANDS-ON LAB 

When scheduling a training session, you can set up a Hands-on Lab session and reserve computers for that session.  

To reserve computers for an in-session Hands-on Lab: 

1. On the Schedule Training Session or Edit Scheduled Training Session page, scroll to In-session Hands-on Lab. 

2. Select Reserve computers from lab.  

3. Choose a lab from the drop-down list. Hands-on Labs are set up by your site administrator. 

4. To view the lab description or number of computers set up in a selected lab, click Lab Info. 

5. In the Number of computers box, type the number of computers that you want to reserve. 

6. To check availability of the computers and lab, click Check Availability. 

7. The Computers Available dialog box appears indicating how many computers are available for the time and lab that you 
specified. 

8. Your reservation status appears in the Reservation status box. The reservation status refreshes each time you click Check 
Availability. 

9. To pre-assign computers to registered attendees, select Require attendee registration in the Registration section of the 
Schedule Training Session page.  Requiring attendee registration allows you to assign computers to attendees as they 
register.  

10. When you are finished scheduling your training session and Hands-On Lab, click Schedule at the bottom of the Schedule 
Training Session page. Requiring attendee registration allows you to assign computers to attendees as they register.  
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11. If the computers are available for your scheduled Hands-on Lab, the Session Scheduled dialog box appears with your 
reservation confirmation.  

12. If the computers are not available, the Computers Not Available page appears. Click Close, and select a new reservation 
time or number of computers on the Schedule Training Session page.  

13. Click OK. 

VIEWING THE HANDS-ON LAB SCHEDULE 

You can view the Hands-on Lab schedule from your Training Service website.  

To view the Hands-on Lab schedule: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, expand Host a Session to view a list of links. 

3. Click Hands-on Lab.  The Hands-on Lab View Schedule page appears. 

4. For the lab in which you are interested, under Lab Schedule, click View Schedule.  The Lab Schedule page appears.  

5. Point to a time slot to view details of the lab schedule.  

6. When finished, click Close.  

Assigning Hands-on Lab computers to registered attendees 

You can assign Hands-on Lab computers to attendees as they register for your training session. You can also either assign 
computers to participants during the Hands-on Lab session, or allow participants to choose their Hands-on Lab computer when 
they join the session.  

To pre-assign computers to registered attendees: 

1. Log in to your TrainingCenter website.  

2. On the navigation bar, expand Attend Training to view a list links. 

3. Click Live Sessions.  

4. Click on your session topic.  The Session Information page appears. 

5. Click Attendees.  The Registered Attendees page appears. 

6. Click Pre-Assign Computers. The Pre-Assign Computers page appears.  

7. To assign an attendee to a computer, click on the name of the attendee under Unassigned Attendees.  
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8. To assign multiple attendees to one computer, hold down the Ctrl key while selecting the names of the attendees.  

9. Click Assign. 

10. You can continue to assign computers to attendees or groups of attendees as long as computers are available.  

11. When finished assigning computers, click OK.  

SETTING UP ON-DEMAND HANDS-ON LAB 

To provide attendees with more hands-on training, TrainingCenter supports on-demand Hands-on Lab sessions in which 
attendees connect to remote computers outside a training session to practice what they learn at their own pace. 

You can schedule an on-demand Hands-on Lab session by reserving Hands-on Lab computers. Each of the invited attendees can 
then join the lab session any time within the time limit during the scheduled time frame. 

To set up an on-demand Hands-on Lab session, first reserve computers in one of the labs, and then invite attendees to use the 
reserved computers during the scheduled time.  

Note: Hosts reserve on-demand Hands-on Lab computers from the same pool of remote computers that hosts reserve for in-session Hands-on 
Lab. Labs and remote computers are set up by the Hands-on Lab administrator in your organization. 

ABOUT THE RESERVE LAB COMPUTERS FOR ON-DEMAND USE PAGE 

To access this page, go to the Hands-on Lab page on your TrainingCenter website, and then click any Reserve Computers link. 

Topic: Type a topic for this on-demand session.  

Reserve computers from lab: Choose a lab in the drop-down list, which displays all the labs set up by your Hands-on Lab 
administrator.  

Lab Info: Click this button to view the description of the selected lab and the number of computers in the lab. 

View Lab Schedule: Click this button to view the schedule of the selected lab.  

Number of computers: Specify the number of computers you want to reserve from the selected lab.  

Starting time and Ending time: Attendees can join the lab session during the time frame you specify here. 

Time zone: Specify the time zone in which you want to view the lab session time. 

Total time limit per attendee: You can specify up to 12 hours for each attendee. 

Note: Between the starting and ending times, an attendee can use a reserved computer within the specified time limit. 

SCHEDULING ON-DEMAND HANDS-ON LAB 

To schedule an on-demand Hands-on Lab session, first reserve Hands-on Lab computers for the session. Then invite attendees to 
use the reserved computers during the scheduled time. 
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To schedule an on-demand Hands-on Lab session: 

1. Go to the Hands-on Lab page on your TrainingCenter website.  

2. Click the Hands-on Labs tab. 

3. In the On-demand Lab column, click any Reserve Computers link. 

4. On the page that appears, specify the reservation options.  

5. Click Reserve. 

INVITING ATTENDEES FOR ON-DEMAND HANDS-ON LAB 

Once you finish scheduling an on-demand Hands-on Lab session, you can invite attendees to the session by sending them 
invitation email messages. 

To invite attendees to a scheduled on-demand Hands-on Lab session: 

1. On the Hands-on Lab page, under the My Reservations tab, click On-demand use.  

2. In the Session Name column, click the link for the topic of the Hands-on Lab session. 
The On-Demand Hands-on Lab Session Information page appears.  

3. Click Invite Attendees. 

4. Do any of the following as appropriate: 

a. Click Select Live Sessions to invite all attendees from an existing training session. 

b. Type the email addresses of the individuals you want to invite in the Invited attendees text box. 

c. Click Select Attendees to select contacts from an address book stored on your TrainingCenter website.  

5. Optional: Click Edit Email Options to customize the content of the invitation email message. 

6. Click OK. 

CHANGING RESERVATIONS 

You can change your reservations for on-demand Hands-on Lab at any time. 

To change your reservation for an on-demand Hands-on Lab session: 

1. On the Hands-on Lab page, click the My Reservations tab, and then click On-demand use.  

2. In the Session Name column, click the link for the Hands-on Lab session reservation you want to change. 
The On-Demand Hands-on Lab Session Information page appears.  

3. Do one of the following as appropriate: 

a. To make changes to the reservation, click Change Reservation.  

b. To delete the reservation, click Cancel Reservation.  

4. If you click Change Reservation, the Change Hands-on Lab Reservation page appears. 

5. Make your changes.. 

6. Click Change Reservation. 

STARTING A HANDS-ON LAB SESSION 

If you have scheduled Hands-on Lab, you can start a Hands-on Lab session within 15 minutes of the reserved time. The presenter 
is responsible for managing the Hands-on Lab session. 
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To start a Hands-on Lab session:  

1. In the Session window, on the Lab menu, click Start Hands-on Lab.   
The Start Hands-on Lab dialog box appears showing which lab and how many computers are reserved. 

Note: You can start the Hands-on Lab session 15 minutes or less before the scheduled reserved time. If you try to start the Hands-on Lab 
session earlier than 15 minutes before the scheduled reserved time, an error message appears informing you to start the Hands-on Lab 
session during the reserved time.  

2. Under Computer Allocation, select one of the following: 

a. Allow attendees to choose computers. This allows participants to choose any computer reserved for this session.  

b. Assign attendees to computers manually. When you select this option, participants can only connect to 
computers assigned to them.  

3. Optional: Select the Record remote computers automatically when participants connect checkbox. When you select 
this option, the Record button turns on for all reserved computers. Whenever a participant logs into a reserved computer, 
the computer records the actions. When the participant logs out, the recording stops. 

4. Click Start. 

5. Training Manager contacts the remote computers reserved for your Hands-on Lab session.   Once the reserved computers 
are contacted, the Start Hands-on Lab Confirmation dialog box appears. 

6. The Start Hands-on Lab Confirmation dialog box lists all the computers that are connected to the session and the total 
attendees in the session.  

7. Optional: To limit the number of attendees that can connect to each remote computer, under Limit Attendees, select the 
check box next to Limit. Select the number of attendees that you want to limit to each computer. 

8. Click Done. 
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RECORDING HANDS-ON LAB SESSIONS 

As the presenter, you can record the actions of each remote computer in the Hands-on Lab session. This can be helpful for 
observing how participants use the remote computer during a training session. You can choose to begin recording automatically 
when participants connect to a remote computer, or you can start recording at any time from the Hands-on Lab panel.  

Once you record a remote computer, Training Manager downloads and installs WebEx Player on your computer. You must use 
WebEx Player to play a recording. 

To record remote computers automatically when connected: 

1. In the Session window, on the Lab menu, choose Hands-on Lab Options. The Hands-on Lab Options dialog box appears. 

2. Select the Record remote computers automatically when participants connect check box.  

3. Under Record to folder on remote computer, type a folder location at which to store the recording.  

4. The folder is stored on the remote computer. The names of WebEx Recording Format (WRF) files have a .wrf extension.  

5. Click OK.  

6. Training Manager records all actions taken on the remote computers while participants are connected.  

To start recording from the Hands-on Lab panel: 

1. On the Hands-on Lab panel, select the computer that you want to record from the Computers list.  

2. Click the Record button.   

3. Training Manager records all actions taken on the remote computers while participants are connected.  

To pause recording: 

1. Under Computers on the Hands-on Lab panel, select the computer that you want to pause recording from the list of 
computers.  

2. Click the Pause button.   

3. To resume recording, click the Pause button again.  

To stop recording: 

1. Under Computers on the Hands-on Lab panel, select the computer that you want to stop recording from the list of 
computers. 

2. Click the Stop button.   

ASSIGNING COMPUTERS DURING HANDS-ON LAB SESSIONS 
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If you selected Assign attendees to computers manually in the Start Hands-on Lab dialog box, you can assign computers to 
participants from the Start Hands-on Lab Confirmation dialog box, from the Hands-on Lab panel, or from the Lab menu. 

To assign computers to participants from the Start Hands-On Lab Confirmation dialog box: 

1. In the Start Hands-on Lab Confirmation dialog box, click Assign Computers. The Assign Computers dialog box appears. 

2.  Under Unassigned Participants, select the name or names of participants that you want to assign to a particular computer. 
Hold down the Shift key to select more than one participant. 

3. Under Computers, select the computer that you want to assign to the selected participant. 

4. Click Assign.  

5. To give control of the computer to a particular participant, click Give Control.  

6. When you are finished assigning computers, click OK. 

7. Click Done in the Start Hands-on Lab Confirmation dialog box.  

UNASSIGNING PARTICIPANTS FROM COMPUTERS 

To unassign a participant from a computer, do one of the following: 

• On the Lab menu, point to Assign Computers. In the Assign Computers dialog box, select the name of the participant 
that you want to unassign. Click Unassign. 

• On the Hands-on Lab panel, click Assign. In the Assign Computers dialog box, select the name of the participant that 
you want to unassign. Click Unassign. 

BROADCASTING A MESSAGE TO PARTICIPANTS 

As the presenter, you can choose to broadcast a message to all participants or to select participants in the Hands-on Lab session.  

To broadcast a message,  

1. Do either of the following:  

a. On the Lab menu, point to Broadcast Message To.  
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b. On the Hands-on Lab panel, click the Broadcast Message button.   

2. In the menu that appears, select All or choose a remote computer to which you want to broadcast your message.  The 
Broadcast Message dialog box appears. 

3. In the Message box, type your message.  

4. Click OK. 

5. Your message appears on the selected participants' desktops. 

RESPONDING TO A REQUEST FOR HELP 

If a participant requests help, the Ask for Help indicator appears next to his or her name in the Hands-on Lab panel. 

To respond to a request for help: 

1. Next to the participant’s name, click the Ask for Help indicator.    

2. The Broadcast Message dialog box appears. Type a message in the Message box. 

3. Click OK. 

4. The participant receives your message on his or her desktop. 

Note: You can then connect to the participant's remote computer and use the chat viewer to continue to help the participant. 

TAKING CONTROL OF A HANDS-ON LAB COMPUTER 

As the presenter, you can take control of any Hands-on Lab computer. 
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To take control of a computer: 

1. Connect to the remote computer.  

2. In the Hands-on Lab Manager panel, click the Pass Control button.   

3. You now have control of the remote computer.  

ASKING ALL TO RETURN FROM LABS 

During a Hands-on Lab session, you can ask all the participants to return from the Hands-on Lab session to the main training 
session. You can choose to have the participants return immediately, or you can give them a time limit for returning.  

To ask participants to return: 

1. On the Lab menu, choose Ask All To Return.  The Ask All to Return dialog box appears. 

2.  Do either of the following: 

a. Select within and choose a time in minutes from the drop-down list. This option gives participants time to finish the 
tasks that they are working on. 

b. Select immediately and end all sessions after 30 seconds. 

3. Click OK.  A confirmation dialog box appears in which you confirm your request to ask all participants to return from 
Hands-on Lab. 

4. Click OK. 

5. All participants receive a message asking them to return from Hands-on Lab. The Hands-on Lab sessions end either after 30 
seconds or after the time you selected in the Ask All To Return dialog box.  

ENDING THE HANDS-ON LAB SESSION 

For training hosts only  

You, as the training session host, can end the Hands-on Lab sessions at any time.  
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To end a Hands-on Lab session: 

1. On the Lab menu, click End Hands-on Lab. A confirmation message appears. 

2. Click OK. 

3. The Hands-on Lab session ends for all participants. 

Note: If you do not manually end the Hands-on Lab sessions, they end automatically when your reservation for Hands-on Lab computers expires. 
A message appears on your screen 15 minutes before your reservation expires. If the computers have not been reserved for another training 
session, you can continue to connect to the Hands-on Lab computers. If the host of the new session attempts to connect to the reserved computers, 
you will be disconnected from the reserved computers. 

 

TEST ING AND GRADING 

ABOUT TESTING AND GRADING 

The Testing feature in TrainingCenter gives you direct control over test creation, test delivery, test management, and scoring and 
grading, and the ability to track each attendee's performance. It also gives you access to the Test Library on your organization's 
TrainingCenter website where you can store your tests and share your tests with other hosts in your organization. Tests are web-
based and easy to manage. 

You can add tests to a training session and administer them at all stages of the learning process: 

• Pre-session --Test attendees' knowledge so you can plan more effective and relevant training content 

• In-session --Ensure that attendees follow the training content; receive feedback from attendees 

• Post-session --Test attendees' comprehension of the training content; helps you plan your next training sessions based on 
the results of a post-session test 

Note: You can also import a poll questionnaire and convert it to a web-based test. 

ADDING TESTS TO A SCHEDULED TRAINING SESSION 

To test attendees, you must add tests to the training session that they will be attending. 

Before you can add tests, do the following to turn on the Testing feature: 

• Schedule, but do not start, a session. 

• Require attendee registration for the session. 

To require attendee registration, select Attendee Registration when scheduling or updating the session. 

To add a test to a scheduled training session: 

1. Go to the Session Information page for the session by clicking the session topic. 

2. Click Add New Test on the Session Information page. 

3. On the Add Test page, select one of the following and click Next: 

a. Create a new test  

b. Copy an existing test from the Test Library  

4. Select the test you want to copy from the Test Library and click Next. 

5. Import test questions from saved test or poll questionnaire (*.atp file)  
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6. Select the file and click Next. 

7. Compose or edit the test, and click Save. 

8. The Manage Test page appears. The following figure shows an example of the Manage Test page. 

9. To return to the Session Information page, click Done.  

10. Follow the same instructions to add multiple tests to a session. 

UNDERSTANDING THE TEST LIBRARY 

The Test Library serves as a repository of tests on your organization's TrainingCenter website. In the Test Library, you can do the 
following: 

• Create, edit, duplicate, or delete a test 

• Import a poll or test questionnaire, with an .atp file extension, and convert it to a test 

• Copy your tests to the Shared Tests section so other training hosts can access the tests 

• Copy shared tests to the Private Tests section 

The tests you create or import appear in the Private Tests section. 

To access Test Library: 

1. Log in to your TrainingCenter website. 

2. Click Test Library under Host a Session on the left navigation bar. The Test Library page appears. 

CREATING A NEW TEST 
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You can create a test in the Test Library or create a test and then add it to a scheduled training session. You can add a test to a 
recorded session only if your site includes the Presentation Studio Integration option. 

To create a test: 

1. Do one of the following: 

a. On the Test Library page, click Create New Test. 

b. On the Session Information page, click Add New Test. Select Create a new test, and click Next. 

The Create Test page appears. 

2. Specify the following: 

a. Test title and description 

b. Maximum score -- Select the check box and type the score in the text box to specify the maximum score an attendee 
can receive. 

c. Grade -- Select the check box to assign a grade based on the attendee's scores. Click the Specify Grades link to 
specify a grading scale. 

3. Display question -- Select one of the following: 

a. All questions in one page 

b. One question per page 

4. Click the Insert Question link to add a question or instructions to the test. The Add Question window appears. 

5. Click the Question Type drop-down list. 
The following table defines each question type: 
 

 Question type Description 
Essay  A question that requires attendees to type text answers 
Fill in the blanks  A question that requires attendees to type text answers in the blanks 
Instructions  Instructions that you can provide attendees in the beginning of a test 
Multiple Choice  A question that requires attendees to select one correct answer 
Multiple Response  A question that requires attendees to select more than one correct answer 
True/False  A question that requires attendees to indicate whether the statement in the question is true or false 

6. In the drop-down list, do one of the following: 

a. Choose Instructions to add instructions in the beginning of the test, and click Save. 

b. Choose one question type, compose the question, specify the correct answers, and click Save. 

Note: To save you time in scoring, TrainingCenter automatically checks attendees' answers against the correct answers you specify. You 
must specify answers for all question types except Essay. Once you start a test, you cannot change the questions or answers. Ensure that 
the answers are correct before you start the test or the scoring will be incorrect.  

7. Follow the same instructions to add additional questions to the test. 

8. In the Scoring Panel area for each question, specify a score for the correct answer and optionally type scoring guidelines or 
comments for the person who will score the test. 

9. To rearrange questions, click the Move Up or Move Down links. To edit a question, click Edit. 

10. Click Save. 

CONVERTING TEST OR POLL QUESTIONNAIRES TO TESTS 

You can import test or poll questionnaires that were created and saved previously and convert them to web-based tests. 

Test or poll questionnaire files have an .atp extension. 
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To convert a test or poll questionnaire to a test: 

1. Do one of the following: 

a. On the Test Library page, click Import. 

b. On the Session Information page, click Add New Test , select Import test questions from saved test or poll 
questionnaire (*.atp file) , and click Next . 

2. Select the file you want to import and click Next. 

3. The questionnaire is copied to the Edit Test page. 

4. Edit the questions if necessary. 

5. Click Save. 

SPECIFYING TEST DELIVERY OPTIONS FOR A SCHEDULED TRAINING SESSION 

The Test Delivery Options page appears during the process of adding a test to a scheduled training session. On this page, you 
determine when and how to deliver the test. Once you start a test, you cannot change the delivery options. 

The following figure shows an example of the Test Delivery Options page. 

Specifying the delivery method 

Next to Delivery method, select one of the following: 

• Start this test within a live session --You can start the test anytime during the training session. 

• Deliver this test on the website --Specify the starting and due dates and times for the test. Attendees can take the test 
anytime between the starting and due dates and times. 
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Specifying a time limit 

Next to Time limit, select one of the following: 

• No time limit  

• Attendees must finish the test within X minutes  
Type the length of time in the text box. 

Note: If the test is set to be delivered outside the session, attendees can take the test anytime between the starting and due dates but must finish 
the test within the specified length of time. 

Sending email messages to attendees 

Next to Email attendees, select from the following: 

• Invitation email to take the test --Specifies when to send the email before the test starts 
Type the number of days before the test starts to send the email in the text box. 

• Scoring and grading report --Sends grade reports to attendees after the host finishes scoring their tests or after the host 
updates the scores or comments 

Sending email messages to attendees 

Next to Email attendees, select the Scoring and grading report check box to send grade reports to attendees after the host 
finishes scoring their tests or after the host updates the scores or comments. 

STARTING AND MANAGING SCHEDULED TRAINING SESSION TESTS 

You can use the Manage Test page to manage every aspect of a test. 

To access the Manage Test page for a test: 

1. Click the test topic on the Session Information page. The following figure shows an example of the Test section on a 
Session Information page. 
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2.  Click the Manage button to open the Manage Test page. 

3.  The options on the Manage Test page vary, dependent on the delivery options and the status of the test. Tests can fall into 
the following categories: 

a. Pre-session tests and post-session tests 

b. In-session tests 

MANAGING PRE-AND POST-SESSION TESTS 

To manage pre- and post-session tests: 

Pre- and post-session tests automatically start at the time you specified on the Test Delivery Options page. 

The following table shows the management options for a pre- or post-session test. 
  

Status Management Options 

Before test starts 
Change delivery options 
Copy the test to Test Library 
Edit test questions 

Test in progress 

End test immediately 
Extend due date of the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

After test ends 

Re-start the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

MANAGING AND STARTING IN-SESSION TESTS 

You administer an in-session test during a training session. Attendees take the test during the session rather than before or after.  
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To manage in-session tests: 

1. Specify Start this test within a live session option on the Test Delivery Options page when adding the test to the session. 

2. After the session starts, choose Testing in the drop-down list on the Participants & Communications panel. 

3. Select the title of the test, and then click Launch for All. 

4. On the page that appears, click Start Test. 

The following table shows the management options for an in-session test. 
  

Status Management Options 

Before test starts 
Change delivery options 
Copy the test to Test Library 
Edit test questions 

After you click Launch for All  
Start the test 
Copy the test to Test Library 
Edit test questions 

Test in progress 

End the test immediately 
Increase time limit if you have specified it 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

After test ends 

Re-start the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

Test suspended in the event of a session crash 

Resume the test 
Re-start the test 
View and score attendees' answers 
Copy the test to Test Library 
View test questions 

SCORING AND GRADING ANSWERS FOR A TEST 

TrainingCenter automatically checks attendees' answers against the correct answers you specified when creating the test and then 
scores the results. 

An entire test is scored automatically if it contains no essay or fill-in-the-blanks questions. In this case, attendees can view test 
results once they submit their answers. 

If a test contains essay or fill-in-the-blanks questions, you must manually review and score the test. A complete score is 
unavailable until you finish scoring the essay or fill-in-the-blanks questions. 
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To score the answers for a test: 

1. Go to the Manage Test page for the test. 

2. In the Student Answers section, click View and Score Answers. 

3. The Submitted Tests page appears. This page lists attendees who have submitted their tests and attendees who have received 
their scores and grades, if assigned. You can also view the questions and grading scale, if specified. 

4.  To score an attendee's test, click the Score Answers link for the attendee or click the attendee's name. 

5. The Score Submitted Answers page appears. All answers, except for essay questions, are automatically scored. A partial 
score appears in the Results area. Although fill-in-the-blanks answers are scored automatically, you may want to review 
them and change the scores, if necessary. 

6. Review the essays or fill-in-the-blanks answers that need manual scoring, and specify the scores for the essays. 

7. To quickly go to a question that needs manual scoring, go to the Unscored questions section, choose a question in the 
drop-down list, and click Go. 

8. To change the score for a fill-in-the-blanks answer, select correct or incorrect for the question. Clicking Save updates 
the score. 

9. Optionally type comments for the attendee. 

10. Click Save to update the score or your comments. 

11. The test results are updated on the View Test Results page. If you have specified to send grade reports to attendees, the 
attendee receives the update via email. 



G
L

O
B

A
L

 C
O

N
F

E
R

E
N

C
IN

G
 S

O
L

U
T

IO
N

S
 

 
 
 

 WWW.INTERCALL.COM   1-800-374-2441

AAP/EOE 
Last Rev.  12.18.06 

WebExTM and  MyWebExTM are either registered trademarks or 
trademarks of WebEx Communications Inc. in the United States 
and other countries. 

VIEWING TEST RESULTS 

Attendees can click View Results on the Session Information page or, for a recorded session created using Presentation Studio 
Integration, on the Test Submitted page, to view their test results. They can also click a link sent via email to view their test 
results if you have specified to send grade reports to attendees. 

Before you end the test, the View Test Results page contains the score and grade, if assigned. After you end the test, the page 
contains test details, including the attendee's score and grade, if assigned, correct answers, and your comments. 

For recorded session tests, the View Test Results page contains all test details, including the attendee's score and grade, if 
assigned, correct answers, and your comments. 

To view each attendee's performance, or edit scores or comments for each attendee, click View and Score Answers on the 
Manage Test page. 

 

PUBL ISHING A RECORDED TRAINING SESS ION 

ABOUT PUBLISHING RECORDED TRAINING SESSIONS 

If you or another user records a training session using WebEx Recorder, you can publish the recording on your TrainingCenter 
website. Users on your site can either view or download the recording from the Recorded Sessions page. 

You can publish a recording by: 

• Uploading it to your TrainingCenter website. 

• Specify the web address, or URL, at which the recording resides on another server. 

When publishing a recording, you can: 

• Specify whether all users on your site can view or download the recording, or only users who have an account on your site 

• Password-protect the recording 

• Require that users register to view or download the recording 

Once you publish a recording, you can: 

• Edit information about it 

• Stop publishing it 

OPENING YOUR LIST OF RECORDED TRAINING SESSIONS 

To publish, delete, or edit information about a recording, you must open your list of recorded training sessions. 
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To open your list of recorded training sessions: 

1. Log in to your TrainingCenter website.  

2. Click MyWebEx > My Files > Training Recordings. The Training Recordings page appears. 

PUBLISHING A RECORDED TRAINING SESSION 

You can publish a recorded training session that was created with WebEx Recorder. A recording that you publish must be in the 
WebEx Recording format (WRF), which has a .wrf extension. 

To publish a recording, you can do one of the following: 

• Upload the recording to the server for your TrainingCenter website. The file that you upload must reside on your computer 
or a local server. 

• Specify the web address, or URL, for the recording on a publicly accessible web server. Because your storage space for 
recordings on your site is limited, you can use this option to publish an unlimited number of recordings, or recordings with 
large file sizes. To use this option, you may need to ask your organization's webmaster to store the recording on the server 
and provide you with its URL. 

To publish a recorded training session: 

1. Open the Training Recordings page.  
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2. Click Add a Recording. The Add a Recording page appears. 

3.  In the Topic box, specify the topic of the recorded training session. 

4. Under Type, select an option to specify whether the recording is listed on the Recorded Sessions page on your site and, if it 
is listed, which types of users can view the recording. 

5. In the Presenter box, specify the presenter's name. 

6. In the Email address box, specify the presenter's email address. 

7. In the Description box, enter a description of the recorded training session. 

8. Optional: Specify the agenda for the training session. 

9. Under recording file, publish the recording by clicking Browse, and then select the file that you want to publish. 

Note: The maximum file size is 50 MB. Files that exceed the maximum will not be created, causing the Recording Creation Failed page to 
appear. 

10. Click Open. 

Note: Choosing this option will disable the duration, file size, date, and destination address fields. The view and download option will also 
be disabled. 

11. Upload the recording to your TrainingCenter website: 
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a. Click Browse, and then select the file that you want to publish. 

b. Click Upload File. 

12. Specify the URL for the file on another server: 

a. Click Specify URL. 

b. Type the URL in the box. 

13. Specify the duration, file size, and date for the recording. 

14. Optional: Specify a destination URL--that is, a web page that appears automatically once a visitor finishes viewing a 
recording. 

15. Optional: Specify file access options. 

16. Click Add. 

17. Click OK. 

 

CONTACTING INTERCALL  

TECHNICAL SUPPORT:  For information about receiving technical support for TrainingCenter, refer to the TrainingCenter 
website at w w w . t r a i n i n g c e n t e r s i t e . n e t  and select Contact Us. 

TRAINING:  For information about receiving Training on TrainingCenter, refer to the TrainingCenter website at 
w w w . t r a i n i n g c e n t e r s i t e . n e t  and select Training. 

SALES:  For information about InterCall’s conferencing services, please contact your sales representative or visit 
w w w . i n t e r c a l l . c o m .  

For additional information about using TrainingCenter, please refer to the Help section on the TrainingCenter website at 
w w w . t r a i n i n g c e n t e r s i t e . n e t .  


